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Introduction
The Microsoft Office Home and Student 2013 suite of programs provide the tools you need 
for easy and efficient word processing, presentation planning, spreadsheet creation, and 
note taking. Microsoft Office Home and Student 2013 Step by Step offers a comprehensive 
look at the features of Office that most people will use most frequently, particularly those 
new to Office Home and Student 2013.

Who this book is for
Microsoft Office Home and Student 2013 Step by Step and other books in the Step by Step 
series are designed for beginning to intermediate level computer users. Whether you are al-
ready comfortable working in Office and want to learn about new features in Office Home 
and Student 2013 or are new to Office, this book provides invaluable hands-on experience 
so that you can work with Microsoft Word, PowerPoint, Excel, and OneNote.

How this book is organized
This book is divided into 29 chapters. Chapters 1–4 provide information on Office funda-
mentals, including how to work in the Office environment, how to avail yourself of shared 
Office features across applications, and how to share and collaborate with Office 365 servic-
es. Chapters 5–10 show you how to create, read, and navigate, format, organize, and share 
Word documents. Chapters 11–16 cover how to design and create impactful presentations 
in PowerPoint, including working with themes, masters, and layout, along with multime-
dia, creating customized graphics, and finalizing and making your presentation. Chapters 
17–23 take you through the steps of creating, editing, and formatting database worksheets 
and workbooks, manipulating and analyzing data in spreadsheets, and creating charts and 
graphics. Chapters 24–29 cover all the features of OneNote, and show how to work with 
notebooks, sections, and pages, and how to organize and share your notes.

The first chapter of each of the five parts of the book contains introductory information 
that will primarily be of interest to readers who are new to a particular Office application 
or are upgrading from an earlier version. If you have worked with a more recent version of 
Office, you might want to skip past that material.
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This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform with Office Home and Student 2013. If you start at the beginning 
and work your way through all the exercises, you will gain enough proficiency to be able 
to work with all the Office Home and Student applications. However, each topic is self-con-
tained, so you can jump in anywhere to acquire exactly the skills you need.

Download the practice files
Before you can complete the exercises in this book, you need to download the book’s prac-
tice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/OfficeHomeStudent2013SbS/files

IMPORTANT  Microsoft Office Home and Student 2013 is not available from this 
website. You should purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 2: Using shared Office features Fabrikam Management Team.pptx

Sample Picture.jpg
Simple to-do list.xlsx

Chapter 6: Reading and navigating documents Fabrikam Rebrand Campaign.docx
Newsletter_A.docx
Newsletter_B.docx

Chapter 7: Creating and editing documents List Example.docx
Newsletter_C.docx
Sample Logo and Address.docx

Chapter 8: Formatting documents Fabrikam Rebrand Campaign_A.docx
Fabrikam Rebrand Campaign_B.docx
Fabrikam Rebrand Campaign_C.docx
Fabrikam Rebrand Campaign_D.docx
Fabrikam Rebrand Campaign_final.docx

Chapter 9: Organizing documents Example Newsletter.docx
List Example.docx
List Example_B.docx
List Example_C.docx

http://aka.ms/OfficeHomeStudent2013SbS/files
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Chapter File
Chapter 10: Finalizing documents Fabrikam Newsletter.pdf

Newsletter_B.docx
Chapter 12: Working with themes, masters, and 
layouts

SampleContentA_Start.pptx
SampleContentB_Start.pptx
SamplePictureB.JPG

Chapter 13: Creating on-slide content SampleContentA_start.pptx
SampleContentA_end.pptx
SampleContentB_start.pptx
SampleContentB_end.pptx
SampleContentC_start.pptx
SampleContentC_end.pptx
SampleContentD_start.pptx
SampleContentD_end.pptx
SampleContentE_start.pptx
SampleContentE_end.pptx
SampleContentF_start.pptx
SampleContentF_end.pptx
SampleContentG_start.pptx

Chapter 14: Creating Office graphics SampleContentA_Start.pptx
SampleContentB_Start.pptx
SamplePictureB.JPG

Chapter 15: Working with multimedia Fabrikam Employee Excursion.wmv
SampleContentA_start.pptx
SampleContentA_end.pptx
SampleContentB_start.pptx
SampleContentC_start.pptx
SampleContentD_start.pptx

Chapter 16: Finalizing and presenting SampleContentA_Start.pptx
SampleContentB_Start.pptx
SampleContentC_Start.pptx
SampleContentD_Start.pptx

Chapter 18: Creating and editing worksheets Fabrikam-Employees_start.xlsx 
Fabrikam-Management_start.xlsx 
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Chapter File
Chapter 19: Manipulating numbers and text Fabrikam-Management2_start.xlsx 

Fabrikam-Seven-Year-Summary_start.xlsx 
Fabrikam-Seven-Year-Summary2_start.xlsx 
Loan_start.xlsx 
Real-Estate-Transition_start.xlsx 

Chapter 20: Analyzing data 2015Projections_start.xlsx
Fabrikam-Jan-2013-Sales_start.xlsx
FabrikamJanSales2013.txt
FabrikamQ1SalesDetail_start.xlsx
JanSales2_start.xlsx
RealEstateTransition_start.xlsx

Chapter 21: Formatting worksheets Custom Formats 2_start.xlsx
Custom Formats 3_start.xlsx
Custom Formats_start.xlsx
FabrikamSummary_start.xlsx
FabrikamSummary2_start.xlsx
FabrikamSummaryTheme_start.xlsx
FabrikamSummaryTheme.xlsx
Real-Estate-Transition_start.xlsx

Chapter 22: Manipulating workbooks and 
worksheets

FabrikamQ1_start.xlsx
FabrikamQ1-B_start.xlsx
Q1-Summary_start.xlsx
Q1-Transactions_start.xlsx
Q1-Transactions2_start.xlsx
UnitSales_start.xlsx
UnitSales2_start.xlsx

Chapter 23: Creating charts and graphics FabrikamLogo_start.xlsx
FabrikamSalesTable_start.xlsx
FabrikamSalesTable2_start.xlsx
FabrikamSalesTable3_start.xlsx
FabrikamSalesTable4_start.xlsx
FabrikamSalesTable5_start.xlsx
Logo_start.xlsx
Report_start.xlsx
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Chapter 29: Saving time with OneNote 29 Practice Image 1.jpg
29 Practice Spreadsheet 1.xlsx

Your companion ebook
With the ebook edition of this book, you can do the following:

▪▪ Search the full text

▪▪ Print

▪▪ Copy and paste

To download your ebook, please see the instruction page at the back of the book.

Getting support and giving feedback
The following sections provide information about getting help with Office Home and 
Student 2013 or the contents of this book and contacting us to provide feedback or report 
errors.

Errata
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on our 
Microsoft Press site: 

http://aka.ms/OfficeHomeStudent2013SbS/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, email Microsoft Press Book Support at mspinput@microsoft.
com.

Please note that product support for Microsoft software is not offered through the ad-
dresses above.

http://aka.ms/OfficeHomeStudent2013SbS/errata
mspinput%40microsoft.com
mspinput%40microsoft.com
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We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable 
asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at: http://twitter.com/MicrosoftPress/.

http://www.microsoft.com/learning/booksurvey
http://twitter.com/MicrosoftPress/
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Getting comfortable in Office 
Home and Student 2013

IN THIS CHAPTER, YOU WILL LEARN HOW TO

▪▪ Explore the Office environment.

▪▪ Work with Office files.

▪▪ Recover unsaved files and versions.

▪▪ Customize the user interface.

▪▪ Customize the ribbon.

▪▪ Choose the right application for the task at hand.

One of the biggest advantages of using Microsoft Office Home and Student 2013 is the 
similarities across the applications. The most obvious is the user interface, which is the over-
all look and feel of the application and how you interact with it. If you’ve used previous 
versions of Office, you may notice that many commands and features are nearly identical to 
those in past releases of Office, if not exactly the same, such as the commands for copying 
and pasting information, formatting text, creating charts, or inserting pictures. All of these 
similarities greatly reduce the learning curve, which allows you to apply the functionality in 
one application across the entire Office suite. 

As you apply that knowledge and learn more about each application, you’ll likely discover 
similar functionality that may not be initially obvious. For example, you can create a com-
pany newsletter by using Microsoft Word or PowerPoint. You can document company 
meeting notes in Microsoft OneNote or Word. And you can store lists of data in both Word 
and Microsoft Excel. 

In this chapter, you’ll learn about the Office environment, which includes the user interface, 
application options, and Office settings, plus you’ll learn about Office terminology, Help 
options, and other functionality available in Office. This chapter also covers basic instructions 
for starting an Office application and working with Office files. At the end of this chapter, 
you’ll get an overview of each application and tips for choosing the right application for 
various tasks. 

1
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PRACTICE FILES  You don’t need any practice files to complete the exercises in this chapter. 

Exploring the Office environment
The first step in getting comfortable with Office Home and Student 2013 is to become fa-
miliar with your Office surroundings. In this section, you’ll explore the user interface along 
with application options and settings that are shared across the Office applications. 

TIP  Even if you’re already comfortable with this information from working with a previous 
version of Office, please read this section for tips that you may have not previously 
discovered.

You typically start an Office application from the Windows Start screen in Windows 8 or 
the Start menu in Windows 7. You can also start an application and open a file at the same 
time by opening a file sent to you as an email attachment or by double-clicking a file from 
somewhere in your computer environment, such as your Windows desktop. 

With the exception of OneNote, when you start an application without opening a file, the 
new application Start screen appears.

TIP  OneNote doesn’t have an application Start screen. When you start the application, the 
main window is displayed. 
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From the application Start screen, you can open a recently used file, open an existing file, or 
create a new file from a template. After you create a new file or open an existing one, the 
main window will be displayed.

1
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RibbonRibbon tab
Quick Access Toolbar

File tab
Dialog box launcher

Group Status bar

Window controls
Gallery More button

Collapse ribbon

The application window has the following elements:

▪▪ Ribbon  The main component of the Office user interface and where you’ll find the 
primary commands for working with the content of your Office files. The ribbon in-
cludes tabs that have commands associated with a specific task. For example, objects 
that you insert in an Office document; like a picture, chart, or shape; are located on 
the Insert tab. This task-oriented organization also extends to the commands them-
selves, which are placed in related groups. For example, frequently used commands 
for formatting text are all located in a group named Font in most applications. 

TIP  Some commands on the ribbon have what’s known as a split control, which is a 
combination of a button and an arrow. An example is the Bullets command, found in 
Word on the Home tab in the Paragraph group. If you click the button, the default 
option, or the last option you selected during your editing session, will automatically 
be applied. When you click the arrow next to the button, a list of options will display, 
such as a list of available bullets.
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Note that for larger split controls, like the Paste button, the arrow will appear below 
the button instead of to the right. An easy way to determine if you’re using a split 
control is to point to the button. If only the button or the arrow is highlighted rather 
than the entire button, then it’s a split control. 

▪▪ Title bar  Appears at the top of the application window and displays the name of the 
active file and application name. In most standard Windows applications, including 
the Office applications, the title bar also has the program icon on the far left.

▪▪ Window controls  Located on the far right of the title bar. Along with the standard 
Minimize, Restore Down/Maximize, and Close buttons, there are two additional 
buttons:

▪▪ Help  Clicking this button displays help for the application.

▪▪ Ribbon Display Options  Clicking this button gives you a list of choices for viewing 
the ribbon.
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The Auto-Hide Ribbon option gives you nearly a full-screen view because it also 
hides the status bar along with the ribbon. Show Tabs and Show Tabs And Commands 
toggle the ribbon between a collapsed or expanded state, displaying only the ribbon 
tabs or displaying both the ribbon tabs and commands. 

SEE ALSO  For more information about how to hide, collapse, and expand the ribbon, 
see the “Customizing the user interface” section later in this chapter.

▪▪ Quick Access Toolbar  Appears on the left end of the title bar by default. Each ap-
plication has its own set of frequently used commands that are specific to the applica-
tion. The most common commands are Save, Undo, and Redo.

▪▪ Status bar  Located at the bottom of the application window; displays information 
about the application or current file. In most applications, view controls and the zoom 
slider are located on the right end of the status bar. 

▪▪ Dialog box launcher  Appears in the lower-right corner of a group when additional 
options for the related set of commands are available. Clicking the dialog box launcher 
opens a dialog box or task pane.

▪▪ Tool tabs  Appear in the ribbon when additional commands are available for a se-
lected object, such as a table, picture, chart, or drawing object.

TIP  You can quickly activate a tool tab for most objects by double-clicking the 
object. 

▪▪ Gallery  A visual list of choices, such as a collection of formats that offer multiple 
options. A gallery also refers to a set of related tools.
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TIP  Many galleries have additional options that may not appear in the ribbon. To 
view gallery options, right-click a gallery item. For example, to lock a shape for multi-
ple uses, right-click a shape in the Shapes gallery and then click Lock Drawing Mode. 
To dismiss this mode, press the Esc key. 

▪▪ Live Preview  Enables you to view changes like pasted text or picture formatting 
prior to making a modification.
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TIP  Live Preview is available in all applications except OneNote.

▪▪ Mini toolbar  Appears on the screen in most applications when you have text or an 
object selected; provides quick access to the most-used formatting commands. 

TIP  The Mini Toolbar may also appear when you right-click selected text or objects.

▪▪ ScreenTips  ScreenTips provide descriptions of commands and are displayed when 
you point to a ribbon command. If the command has an associated keyboard shortcut, 
that shortcut will appear in parentheses next to the name of the command. Several 
ScreenTips also include detailed help or a feature preview. For instance, in Excel, the 
ScreenTip for the Conditional Formatting command on the Home tab in the Styles 
group includes a detailed explanation for how to use conditional formatting. It also in-
cludes a preview of how data bars and an icon set are displayed for a range of values. 
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TIP  If a command has an associated Help topic, Tell Me More is displayed at the bot-
tom of the ScreenTip. Clicking the link displays the Help topic. 

▪▪ KeyTips  Enable you to navigate the ribbon by using the keyboard. To display KeyTips, 
press and release the Alt key. The KeyTips are the letters, numbers, or combinations of 
letters and numbers that appear on the ribbon. When you press only the Alt key, Key-
Tips for the ribbon tabs and Quick Access Toolbar are displayed. To view KeyTips for a 
specific ribbon tab, after you press the Alt key, press the corresponding KeyTip on the 
keyboard. For example, to navigate to the Home tab and view the KeyTips for that tab, 
press Alt+H. Or to view the KeyTips for the Backstage view, press Alt+F. 

TIP  Commands on the Quick Access Toolbar have sequential KeyTips associated with 
the position of the command. For example, your first command is automatically as-
signed Alt+1.

The Office environment also extends to an area called the Backstage view, which is dis-
played by clicking the File tab on the ribbon.

Whereas the ribbon and Quick Access Toolbar are used for working with the content inside 
a file, the Backstage view is used for working with the entire file and for changing applica-
tion settings. 

The commands in the Backstage view are separated into two groups. The first set is for file-
related commands, such as Info, Open, Save As, and Print. These commands are covered in 
the next section of this chapter. 
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The last set, specifically the Account and Options commands, are related to the application 
and are considered part of the Office environment.

▪▪ Account  This is where you manage a new feature in Office Home and Student 2013 
called an Office cloud account and get information about your Office installation.

NOTE  The previous image is from Microsoft Office 365 Home Premium, which is a 
subscription based edition of Office. The Microsoft Office Home and Student 2013 
edition only includes Word, Excel, PowerPoint, and OneNote.

The User Information area has information about your Office cloud account, like your 
user name and your photo if you’ve elected to add one. This location is also where 
you can set a preferred Office background, with designs such as clouds or circles that 
appear in title bar of your Office applications, or where you can change the Office 
Theme.

SEE ALSO  For more information about Office cloud accounts and connected services, 
see Chapter 3, “Sharing and collaborating.”
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The Product Information area is where you find information about your Office instal-
lation such as the Office suite you have installed and the applications that are in-
cluded. This is also where you can choose how your Office installation is updated and 
view your update history. 

▪▪ Options  This is where you can change a variety of application preferences and 
customize certain behaviors that are specific to the application. In some applications, 
such as Excel and Access, there are also options specific to the active file. 

To close the Backstage view and return to the application window, click the arrow in the 
upper-left corner or press the Esc key. 
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Adjusting your ribbon display
The ribbon is dynamic and adjusts to the size of the application window, your screen 
resolution, and your screen magnification. If you’re using a low resolution, one that 
makes everything appear larger, a small application window, or a screen magnifica-
tion of more than 100 percent, the appearance of groups and buttons may be af-
fected. For example, a gallery or an entire group of commands may collapse to a 
single group button, or button images may appear without labels, or buttons may 
appear stacked vertically instead of horizontally. And when you are resizing an ap-
plication window, if there isn’t enough room to display the ribbon, it could disappear 
completely. You may want to take a few minutes to resize an application window to 
become more familiar with the dynamic ribbon changes. 

To modify your screen resolution in both Windows 8 and Windows 7, right-click an 
empty area of your desktop and then click Screen Resolution. In the Screen Resolution 
dialog box, click Resolution and drag the slider to adjust your resolution. 
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TIP  Screen resolution is expressed as pixels wide × pixels high, such as 1024×768. The 
greater the screen resolution, or the higher the numbers, the greater the amount of 
information that will fit on your screen. The greater the number of pixels wide (the first 
number), the greater the number of buttons that can be shown on the ribbon. Note 
that screen resolution options are dependent on your monitor, but they typically range 
from 800×600 to 2048×1152.

As previously noted, the ribbon also adjusts to your screen magnification. To modify 
your screen magnification in both Windows 8 and Windows 7, right-click an empty 
area of your desktop and then click Personalize. In the lower-left corner, click Display 
and then select your preferred screen magnification. 
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Working with Office files 
In the previous section you learned about the Backstage view and how this area of the ap-
plication is used for file-oriented tasks. In this section, you’ll explore the primary file options 
that are available across the Office applications. 

IMPORTANT  The images and content provided in this section are from Excel. The other 
Office applications have similar options, and major differences between the applications are 
described in tips. 

The pages in the Backstage view that contain commands for working with files are 
described in the following list:

▪▪ Info  In most applications, the Info page displays information about the active file, 
such as the name and location of the file, the author, and the date the file was last 
modified. In all of the applications, you’ll find specialized file management tools that 
are specific to the file and application. The following list provides an overview of 
some of the management tools and features you’ll learn about in other chapters and 
sections of this book. 

▪▪ In Excel, PowerPoint, and Word, you’ll find tools for opening previous versions of 
your current document and recovering files you forgot to save. 

▪▪ In OneNote you use the Info page to manage your open notebooks, by using tools 
such as syncing and sharing options.   
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SEE ALSO  For more information about versions and recovering unsaved documents, 
see the “Recovering unsaved files and versions” section later in this chapter.

▪▪ New  The New page is available in most applications and provides access to tem-
plates that enable you to create new files in the application. You can choose to start 
from scratch and select a blank template, or you can select one that already has con-
tent to help you get started on a specific type of task. For example, across the appli-
cations you’ll find templates that range from newsletters, budgets, and sales reports, 
to contact information and asset tracking.
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NOTE  The templates shown in this book may not be the same as those that appear 
on your screen. New templates are added regularly, which may alter the results. 

To create a new file in the applications that offer templates, simply double-click the 
template you want. Depending on the application and template, you may need to 
provide additional information before a new file is displayed in the application win-
dow. For example, in OneNote, you need to provide a location and file name and 
then save the file before it’s created. This is because OneNote automatically saves 
certain changes.

TIP  In OneNote, there are page templates available in the application, and you can 
find entire notebook templates in the Templates gallery on Office.com. PowerPoint 
templates include designs and layout templates along with task-oriented templates.
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▪▪ Open  The Open page lists the recent files you previously opened and displays a list 
of available places from which you can open files. 
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Pinning the files you use the most
To pin the files you use the most to the recent file list, point to the file and then click 
the pushpin to the right of the file name. Pinned files are placed at the top of the list. 

To unpin the file, click the pushpin a second time. You can pin and unpin frequently 
used folders to the Recent Folders list on the Open and Save As pages as well. You 
can also right-click a recently used file for additional options such as the ability to re-
move a file from the list and clear all pinned files.

TIP  Your recent files list can also be accessed from the main list of tabs in the 
Backstage view. To make this change, click Options, and then click Advanced. 
Locate the Display options and then click Quickly Access This Number Of Recent 
Workbooks. Note that in other applications the option text reflects the type of 
Office document you use for that application. Also in the Display area are options 
to change the number of recent files and unpinned folders that appear on the 
Open and Save As pages.

SEE ALSO  For more information about opening files from Microsoft SkyDrive, 
Microsoft SharePoint Online, or other web locations, see Chapter 3.

To view your recent files, click the Recent option near the top of the view, such as 
Recent Workbooks in Excel. 

To open a file, if it’s in the recent file list, you can click the file to open it in the ap-
plication. If the file you need isn’t in the list, first click the location where the file is 
stored, such as Computer, and then to the right of the location, click a recent folder. 
Or, if the folder you need isn’t in the recent list, click the Browse button at the bot-
tom. Either action displays the Open dialog box. After you select a file to open, click 
the Open button to open the file in the application.

TIP  You can also double-click a location, like Computer, to quickly display the Open 
dialog box. 
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▪▪ Save  When you save a file for the first time and click Save, the Save As page is dis-
played. After a file has been saved, clicking Save in the Backstage view will update the 
file and return you to the application window.

▪▪ Save As  The options on the Save As page are similar to those on the Open page. The 
main difference is that there isn’t a recent file list. 

To save a file, select the location you want, and if the folder you want isn’t in the 
recent folders list, click the Browse button. Either action displays the Save As dialog 
box. After you provide a file name, and if necessary, a different location in the Save 
As dialog box, click the Save button to save the file. 

TIP  As with the Open page, you can double-click a location to quickly display the 
Save As dialog box. 

▪▪ Print  In all Office applications except OneNote, the Print page provides printing and 
page layout options along with a preview of your file. In the Printer area, you can 
choose a different printer and set printer options. In the Settings section, you can 
specify various print and page settings prior to printing your file. 
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To print your file, click the Print button at the top of the view. 

TIP  OneNote has similar print and preview options, but they aren’t combined in the 
same view.

There are also additional file options available on the Share and Export pages. The Share 
page gives you ways to share your file with others, such as sending your file as an email 
attachment or sharing it with others online in a web location or through a web browser. 

On the Export page, you’ll find the ability to save your file in a Portable Document Format 
(PDF) or XML Paper Specification (XPS) format. And in PowerPoint, you have options for 
converting your presentation to a video.

Because the majority of these options vary across Office applications or depend on addi-
tional components, you’ll learn more about them and get step-by-step instructions in other 
chapters.
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Recovering unsaved files and versions
There’s a very good chance you will accidentally close a file without saving it, if you haven’t 
already made such a mistake. The good news is that in Excel, PowerPoint, and Word, you 
may be able to recover your unsaved changes. And if you’ve spent some time working on 
an Office document and discover you’d like to return to a previous version of it, you may be 
able to do that too. File management tools for both of these situations are located in the 
Backstage view, on the Info page.

In the Versions area, a list of autosave files of your current document might be displayed. 

These versions are automatically created while you’re working and are deleted when you 
save and close your Office document. There are a couple of requirements that need to be 
met before an autosave version is created. 

▪▪ You must choose to save AutoRecover information, which is turned on on the Save 
page of the Options dialog box by default. 

▪▪ An AutoRecover save must be made. This save is based on the time interval next to 
the AutoRecover information option and depends on whether you’ve made changes 
that need to be saved. 
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When these conditions are met, you can recover up to your last five autosave versions of 
your current file.

To open a previous version, click the file you want to open in the list and the autosave ver-
sion will open in a separate window. You can then choose to restore your file, save the 
version as a new file, or close it without saving changes. 

TIP  If you only need to recover a portion of an autosave version, you don’t need to restore 
your file to the earlier version. Simply copy the information you need and paste it in your 
main document. 

The Versions area is also where you can recover a file you closed without saving. There are 
two types of unsaved files: those you never saved and unsaved autosave versions. The latter 
applies to files that were previously saved. It’s the last autosave version of a file you closed 
without saving current changes.

IMPORTANT  Files you never previously saved are automatically deleted after four days. 
Unsaved autosave versions are automatically deleted the next time you edit the file and save 
changes. 

As with the autosave version requirements, in order to recover an unsaved file, you must 
elect to save AutoRecover information. And to recover an unsaved autosave version, you 
must also elect to keep the last autosaved version when you close without saving. The latter 
option is also found in the Options dialog box near the top of the Save options. 

To recover unsaved files, click Manage Versions and then do one of the following.

▪▪ In Excel, click Recover Unsaved Workbooks. 

▪▪ In PowerPoint, click Recover Unsaved Presentations.

▪▪ In Word, click Recover Unsaved Documents. 
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The Open dialog box appears and lists the files you can recover for the application you are 
using. Select the file you want and then click Open to open it in the application. And if you 
to want to keep that file, make sure you save your changes. 

Customizing the user interface
In the first section of this chapter, you explored the user interface and became familiar with 
terminology and product-specific functionality. The next step is to personalize your Office 
surroundings to help you settle in and begin making yourself at home.

Here are some of the ways you can customize your user interface: 

▪▪ To free up space on your screen, you can set the ribbon to auto-hide or you can 
toggle the ribbon between a collapsed and expanded state. A ribbon set to auto-hide 
is hidden from view. A collapsed state shows only the tabs, and the expanded state 
shows both the tabs and the commands. 

▪▪ Set the Quick Access Toolbar to appear above or below the ribbon.

▪▪ Add additional commands to the Quick Access Toolbar or remove commands you 
don’t need.

▪▪ Choose the information you prefer to display in the status bar, if applicable to the 
application. 
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Adapting exercise steps
The screen shots shown in this book were captured at a screen resolution of 
1024×768, at 100 percent magnification. If your settings are different, the ribbon on 
your screen might not look the same as the one shown in this book. As a result, exer-
cise instructions that involve the ribbon might require a little adaptation. Our instruc-
tions use this format:

▪▪ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, our instructions use this format:

▪▪ On the Home tab, in the Editing group, click the Find arrow and then, in the 
Find list, click Go To.

If differences between your display settings and ours cause a button to appear differ-
ently on your screen than it does in this book, you can easily adapt the steps to locate 
the command. First click the specified tab, and then locate the specified group. If a 
group has been collapsed into a group list or under a group button, click the list or 
button to display the group’s commands. If you can’t immediately identify the button 
you want, point to likely candidates to display their names in ScreenTips.

In this book, we provide instructions based on traditional keyboard and mouse input 
methods. If you’re using Office on a touch-enabled device, you might be giving com-
mands by tapping with your finger or with a stylus. If so, substitute a tapping action 
any time we instruct you to click a user interface element. Also note that when we tell 
you to enter information in Office, you can do so by typing on a keyboard, tapping in 
the entry field under discussion to display and use the On-Screen Keyboard, or even 
speaking aloud, depending on your computer setup and your personal preferences.
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Customizing the Office environment
In this exercise, you’ll customize your Office environment by collapsing and expanding the 
ribbon, setting it to an auto-hide state, and moving the Quick Access Toolbar below the 
ribbon. 

	SET UP  You don’t need any practice files to complete this exercise. Start Word and 
follow the steps. 

IMPORTANT  Unless otherwise noted, the customizations in this section are not application 
specific.

1	 On the Word Start screen, click Blank document. 

2	 Double-click the active ribbon tab to collapse it.

KEYBOARD SHORTCUT  Press Ctrl+F1 to toggle the ribbon between a collapsed and 
expanded state. 

3	 Click the Home tab to expand the ribbon, and in the Font group, click the Bold 
button. 

4	 Click in the document to return the ribbon to a collapsed state. 

5	 In the window controls at the right end of the title bar, click the Ribbon Display 
Options button and then from the list, click Auto-hide Ribbon.

6	 Click the top of the application window to display the ribbon.

7	 On the Home tab, in the Font group, click the Bold button. 

8	 Click in the document to return the ribbon to an auto-hide state. 

9	 Click the arrow at the end of the Quick Access Toolbar and then near the bottom of 
the list, click Show Below the Ribbon. 
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+ 	CLEAN UP  Set the ribbon to your preferred auto-hide, expanded, or collapsed state. 
Set the position of the Quick Access Toolbar to your preference, either shown above or 
below the ribbon. If you’re continuing to the next exercise, leave Word and your docu-
ment open. Otherwise, exit Word without saving changes to the document you created.

Customizing the Quick Access toolbar
As noted in the introduction of this section, you can also customize the Quick Access 
Toolbar by adding frequently used commands, such as New or Open, or by adding com-
mands directly from the ribbon. Here are two ways you can add additional commands:

▪▪ Click the arrow at the end of the Quick Access Toolbar and then select a command 
from the Customize Quick Access Toolbar list. 

▪▪ Right-click a command on the ribbon and then click Add to Quick Access Toolbar. 

To remove a command from the Quick Access Toolbar, right-click the command and then 
click Remove From Quick Access Toolbar. 

In this exercise, you’ll customize the Quick Access Toolbar by adding and removing 
commands. 
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	SET UP  You don’t need any practice files to complete this exercise. If Word and your 
blank document are still open from the previous exercise, follow the steps. Otherwise, 
start Word, create a new document, and follow the steps.

1	 Click the arrow at the end of the Quick Access Toolbar and then in the list, click Open. 

2	 On the Home tab, in the Font group, right-click the Bold button, and then click Add 
to Quick Access Toolbar. 

TIP  You can also add dialog boxes or a group on the ribbon, such as the Font group, 
to your Quick Access Toolbar for faster access. To do so, right-click a dialog box 
launcher or right-click a group name and then click Add To Quick Access Toolbar.

3	 On the Quick Access Toolbar, right-click the Open button and then click Remove 
from Quick Access Toolbar. 

4	 Remove the Bold button from the Quick Access Toolbar. 

+ 	CLEAN UP  If you’re continuing to the next exercise, leave Word and your document 
open. Otherwise, exit Word without saving changes to the document you created.

TIP  For more information about how to rearrange the commands on your Quick Access 
Toolbar or to add commands that don’t appear on the ribbon, see “Customizing the ribbon” 
later in this chapter. 
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Customizing the status bar
You can also customize the status bar by choosing what you prefer to display. Similar to 
how you customize the Quick Access Toolbar, you can right-click the status bar to custom-
ize it. The Customize Status Bar list shows the available status bar items, and a check mark 
will appear next to those that are currently displayed. You then select or deselect items in 
the list to add or remove them. Note that some items only appear in the status bar when a 
feature is turned on, to help reduce status bar clutter. For example, if you choose to show 
Caps Lock, it will only display in the status bar if you’ve turned caps lock on and are typing 
in all caps.

In this exercise, you’ll customize the status bar in Word. 
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	SET UP  You don’t need any practice files to complete this exercise. If Word and your 
blank document are still open from the previous exercise, follow the steps. Otherwise, 
start Word, create a new document, and follow the steps.

1	 At the bottom of the Word window, note Page 1 of 1 on the left end of the 
status bar. 

2	 Right-click the status bar and then in the Customize Status Bar list, click Page 
Number to turn it off. 

3	 In the Customize Status Bar list, click Page Number again to turn it back on. 

4	 Click in the application window to close the Customize Status Bar options. 

+ 	CLEAN UP  Exit Word without saving changes in the document you created. 

TIP  You can also customize the behavior of the mini toolbar, Live Preview, or ScreenTips. 
To access these settings, display the Backstage view and then click Options. These user 
interface options are located at the top of the General section. Note that the user interface 
options vary across the applications. For example, OneNote does not support Live Preview. 
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Customizing the ribbon
As noted at the beginning of this chapter, one of the biggest advantages of Office is the 
similarities across the applications. In this section, you’ll start applying what you learn about 
one feature to other components that are similar, like the Quick Access Toolbar and ribbon.  

In comparison, both the Quick Access Toolbar and ribbon contain the primary commands 
for an application and can be customized. The main difference between them, other than 
appearance, is that the Quick Access Toolbar holds your most frequently used commands, 
whereas the ribbon provides a more standardized set of commands. However, there may 
be times when you want to make modifications to the ribbon. For instance, there are more 
advanced commands that aren’t in the ribbon by default that you may find beneficial. Or 
you might find you can work more efficiently by moving a command or group to another 
location or tab. 

To customize the ribbon, you display the Backstage view, click Options, and then click 
Customize Ribbon. 
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The left side of the ribbon customization settings area lists commands that can be added 
to the ribbon, and the right side lists the ribbon tabs. You can add commands from the list 
of available commands to any existing group on the ribbon, or you can create a new group 
and add commands to it. 

You can also create a new ribbon tab and add new groups and commands or modify the 
tool tabs that appear when a specific object is selected, like a picture. To access all available 
ribbon tabs, in the Customize The Ribbon area, click the arrow next to Main Tabs and then 
click All Tabs.

Additionally, you can reorder built-in tabs, groups, and commands using the Move Up and 
Move Down arrows on the right side of the dialog box.

In this exercise, you’ll customize the ribbon by adding a new tab, group, and command to 
the ribbon in PowerPoint. You’ll then delete your customizations. At the end of this exercise, 
you’ll apply what you learned about ribbon customization to the Quick Access Toolbar.

	SET UP  You don’t need any practice files to complete this exercise. Start PowerPoint, 
create a blank presentation, and follow the steps.

1	 In the Backstage view, click Options, and then click Customize Ribbon. Below the 
ribbon tab list, click New Tab. 

2	 Click New Tab (Custom) to select it, and then click the Rename button near the 
bottom. 

3	 Enter MY CUSTOM TAB and then click OK.

4	 Click New Group (Custom) and rename it to My custom group.
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5	 From the Popular Commands list, select any command. For instance, select Email. 
Click My custom group and then click the Add button near the middle of the 
Options dialog box. 

IMPORTANT  Commands can only be added to groups on the ribbon. If you don’t 
select a group prior to adding a command, you will encounter an error message. 

6	 To review your customizations, click OK at the bottom of the Options dialog box. 

7	 On the ribbon, click MY CUSTOM TAB and note your custom group and newly added 
command. 

8	 Reopen the Options dialog box and display the ribbon customization options.

9	 If necessary, select MY CUSTOM TAB.

10	 Near the middle of the Options dialog box, click the Remove button to delete your 
custom tab and custom group. 
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11	 Experiment with other ribbon customizations. For example, to reorder tabs, groups, 
or individual commands, make a selection, and then on the right side of the dialog 
box, click the Move Up and Move Down buttons.

12	 After you’re comfortable customizing the ribbon, in the Options dialog box, click 
Customize Quick Access Toolbar and apply what you learned in the previous steps. 
For example, reorder the commands or add new ones. 

13	 To reset all of your ribbon and Quick Access Toolbar customizations, click the 
Reset button near the bottom of the Options dialog box, and then click Reset all 
customizations. 

14	 Click Yes to confirm the deletion of your customizations. 

TIP  To back up your ribbon and Quick Access Toolbar customizations or to share 
them with others, use the Import/Export options at the bottom of the dialog box.

+ 	CLEAN UP  Close the Options dialog box and exit PowerPoint without saving the 
presentation. 

Choosing the right application for the task 
at hand

As noted at the beginning of this chapter, many of the applications have similar functional-
ity. In the next chapter, you’ll learn about shared features that are available to most of the 
Office applications. With so many overlapping capabilities, you may be wondering how to 
determine the application you need to use for your various projects. 

In this section, you’ll get an overview of various tasks you can perform in each application 
that’s available in the Office Home and Student 2013 suite. For the applications that have 
similar functionalities, you’ll receive more information at the end of this section on how to 
choose an application to perform a specific task. 
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Application Tasks
Excel ▪▪ Calculate and analyze numeric information such as budgets, income, 

expenses, loans, and scientific or statistical data.

▪▪ Organize and track information, such as inventory, task lists, projects, 
financial data, and address lists. 

▪▪ Summarize numeric and other data and display results in charts and 
PivotTables. 

▪▪ Create forms that include controls, such as check boxes, drop-down lists, 
and option groups, to be filled in by other users.

OneNote ▪▪ Organize and keep track of your notes and other information in searchable 
notebooks. 

▪▪ Collect information from other Office applications or Windows Internet 
Explorer.  

▪▪ Capture your notes in text, ink, drawings, images, audio, and video.

▪▪ Insert pictures, tables, files, spreadsheets, or diagrams.

▪▪ Collaborate in real time with other people.
PowerPoint ▪▪ Create presentations for a speech, class, or demonstration. 

▪▪ Create photo albums to share with friends and family or for personal use. 

▪▪ Add multimedia such as graphics, video, and audio along with animations.

▪▪ Present your presentation to a live audience or in an online meeting, or 
transform it into a video.

Word ▪▪ Create general documents such as letters, memos, term papers, essays, or 
reports. 

▪▪ Create documents that contain graphics, such as newsletters, cards, flyers, 
invitations, and photo calendars. 

▪▪ Create advanced documents, such as mass mailings that can be printed and 
mailed or sent by email.

▪▪ Create a book or report with a table of contents, indexes, and cross 
references.

▪▪ Create forms that include controls such as check boxes, drop-down lists, and 
date pickers, to be filled in by other users.

▪▪ Generate other documents, such as envelopes, labels, blog posts, and 
webpages. 
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As previously discussed, several of the Office applications provide similar functionality. For 
instance, you can use Word or PowerPoint to create Office documents that include graph-
ics, such as flyers or photo albums. You can create forms in Excel and Word. And you can 
use both Word and Excel for lists of information. 

More often than not, you’ll likely choose the application you’re most comfortable with and 
forgo learning something new. Before you do, keep in mind that each application special-
izes in specific capabilities and can produce better results when selected for certain tasks. 
Think of it as going to a restaurant—if you go to one that specializes in seafood, you might 
find steak on the menu, but it may not be as good as a steak you get from a steak house.

Also keep in mind that what you learn in one application can be applied to another, so the 
learning curve may be easier than you think. Here are a few tips to help you determine the 
right application for specific tasks.   

▪▪ For files that include graphics, consider the type of content you want to include, the 
amount of text, and the complexity of the layout. If it’s a small amount of text and 
you don’t need to use cross-references, fields, or other advanced text features, then 
use PowerPoint. In PowerPoint, it’s easier to move your content and visually align ob-
jects. Plus, you can add vertical and horizontal guides for precision placement. 

▪▪ For photo albums, think about the end result you want. If you want to display the 
album electronically on a computer or projection screen, use PowerPoint. It also 
enables you to add transitions and animations for a professional-looking result. Plus, 
you can convert your presentation to a video that can be published on websites like 
YouTube. 

▪▪ For simple lists of data, such as an inventory or making a task, address, grocery, or 
birthday list, consider using Excel. It has tools for sorting, filtering, and managing your 
lists.

▪▪ For forms, determine whether the form contains calculations. Although Word sup-
ports calculations, creating formulas in Excel is easier and more reliable. However, if 
your form needs to contain advanced text features or needs the page flexibility of a 
word processor, then create your form in Word.

This list is certainly not an exhaustive list of all of the different types of files you can cre-
ate or tasks you’ll perform in your projects. This is a vast topic that could easily warrant its 
own book. But the information provided here should be enough to give you a good start in 
choosing the right application.
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Key points
▪▪ The ribbon and Quick Access Toolbar have commands for working with the content 

of a file. 

▪▪ The Backstage view has commands for working with the entire file or the application. 

▪▪ You can create new documents, workbooks, presentations, publications, notebooks, 
and databases on the New page in the Backstage view.

▪▪ You can open, save, print, share, and export documents in the Backstage view.

▪▪ You can customize the Office user interface and modify application settings to fit your 
workflow.

▪▪ Choosing the right application for specific tasks can help you be more productive and 
get better results.

38      Chapter 1  Getting comfortable in Office Home and Student 2013



Chapter at a glance

Organize 
Organize notebooks and sections,  
page 671

Recover 
Recover deleted sections or pages,  
page 684

Images 
Insert images and ink,  
page 676



Working with notebooks, 
sections, and pages

IN THIS CHAPTER, YOU WILL LEARN HOW TO

▪▪ Create and organize notebooks.

▪▪ Create, organize, and manage sections and section groups.

▪▪ Create and organize pages and subpages.

▪▪ Add and organize notes.

▪▪ Insert images and work with ink and shapes.

▪▪ Recover deleted sections or pages.

Microsoft OneNote is built around the metaphor of a spiral-bound notebook—though of 
course you can have multiple notebooks in OneNote if you like. Each notebook is divided 
into sections, and each section contains the pages where your notes are located.

Before you can get started capturing ideas and research with OneNote, you need to get 
your notebooks, sections, and pages set up. Adding notebooks is easy. You need to decide 
where you want to store them and what you want to call them, but after that, you’re ready 
to go. You can have as many notebooks as you have storage space for. Notebooks must 
have at least one section, but they don’t have to have more than one. Likewise, each sec-
tion has to have at least one page, but can have only one. It’s not likely you’ll want to have a 
notebook that has only a single section and single page in it, but you can.

PRACTICE FILES  You don’t need any practice files to complete the exercise in this chapter.
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Creating a notebook
Creating a notebook is quite simple to do. Simply click the File tab to go to the Backstage 
view and then choose New. The New Notebook page  appears, and it’s time to make your 
first important choice—where to put your new notebook.

OneNote shows you the list of places it recognizes and gives you the option to add a place 
that it doesn’t. It’s worth noting that the Add A Place option only offers  choices of places in 
the cloud. You won’t get local or network locations there. The default location in OneNote 
2013, as in many programs of the Microsoft Office Home and Student 2013 suite, is on your 
Microsoft SkyDrive. On the list shown just previously, you may notice from the icon that the 
first place listed is a Microsoft SharePoint site.
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When you are choosing a location to store your new notebook, there are a few things you 
should know:

▪▪ If you plan to share this notebook with mobile devices, only the Windows Phone 
version of OneNote mobile can access notebooks stored on SharePoint. If you’re an 
iPhone, iPad, or Android user, you’ll need to store the notebook on SkyDrive.

▪▪ If you plan to share this notebook with other PCs, you can select any network location 
those PCs also have access to. A network file share, network storage device, Share-
Point, or SkyDrive will all work fine as long as all of the PCs involved can access that 
location.

▪▪ After you’ve selected your location, give your notebook a name. Choose a name 
that makes sense to you, but try not to make it too long. Marketing and Clients are 
great names. Collection of notes about my trips throughout North Carolina, California, 
Canada, and much of Southern Mississippi is a poor name.

▪▪ With your location chosen and notebook named, click Create Notebook. Your new 
notebook is created and opened in OneNote with a single section and a single page 
within that section.

Creating and organizing sections
OneNote helpfully creates the first section for you, and it’s a safe bet that you don’t really 
want that section to be named New Section 1. To rename the section,  right-click the section 
tab and select Rename from the menu that appears (or just double-click the name on the 
section tab). 
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The same naming guidelines you followed for the notebooks apply to sections, as well. The 
names should be descriptive but not ridiculously long or detailed. 

TIP  Try to avoid using too much punctuation in notebook or section names. Notebooks 
are stored as folders and sections as files; too much punctuation can cause problems with 
synchronization and file storage.

Creating a new section is as simple as clicking the + tab. When you do so, OneNote creates 
a new section and names it New Section x. Rename it to whatever you’d like, as described 
previously. 

If you’d like to rearrange the order of your sections, just click a tab and drag it left or right 
along the tab row above your page or drag a section up or down on the Navigation pane at 
the left.

SEE ALSO  If you need a refresher on section tabs or the Navigation pane, see Chapter 24, 
“Getting comfortable in OneNote 2013.”
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Section groups
Now that we’ve looked at notebooks and sections, you’re probably wondering what section 
groups are. Section groups are merely an organizational construct that let you group your 
sections together in a logical fashion (hence the name). 

▪▪ To create a section group, right-click any of the section tabs or the empty space to the 
right of the section tabs and select New Section Group.

▪▪ A group called New Section Group will be created, which you can right-click and 
rename. 

▪▪ Click the section group to go into it, and click the green swirly arrow at the left side of 
the section tabs to go back up to the previous level.

TIP  You can create just about as many layers of section groups as you want, but don’t get 
too crazy about it. Nine layers of section groups could be rather difficult to easily navigate.

To add a section to a section group, click in that section group and create a new section. To 
move existing sections into a section group, drag them onto the section group.
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Creating and organizing pages
The real york in OneNote gets done on pages. All the rest (notebooks, sections, section 
groups) are just a framework to help organize those pages. Everything we talk about when 
it comes to typing notes or inserting images or ink happens on pages.

Creating a page is quite simple:

▪▪ At the top of the page list on the right side of the screen, click Add Page. A new page 
is created.

As with sections and section groups, your page will have a default name; for example, 
Untitled Page, which you are encouraged to change. There are several ways to rename your 
page:

▪▪ Right-click the page tab and select Rename

▪▪ Click in the page title area of the page (above the horizontal line) and enter a name 
for your page. 

▪▪ Enter some text on the page. In the absence of a formal name, OneNote will use 
whatever the first line of text is for the title of the page.

TIP  You can create as many pages as you like in a particular section.

After you’ve created your page, you can change the order by dragging it up or down in the 
page list on the right side of the window.

TIP  A popular feature request is the ability to sort pages alphabetically. OneNote 2013 
doesn’t include that feature, but there have been Microsoft PowerToys available for 
download in the past that could do it. 

After the page is created, click anywhere on the page to begin adding notes and content.
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Creating subpages
A subpage is a regular page that is indented a bit in the page list in order to show that it is 
a subpage of the page above it. Do you have to use subpages? No, but you might want to, 
because an organizational construct will separate related data onto multiple pages.

To create a subpage, follow these steps:

1	 Create a new page, as described previously, below the page where you want the 
subpage to appear.

2	 Right-click the tab of that new page and select Make Subpage, or drag the subpage 
tab to the right.

Adding and organizing notes
Adding notes to a page in OneNote is as simple as clicking where you’d like the note to ap-
pear and adding your content. Most often, that content tends to be typed notes, but it can 
also be ink, images, web content, and more.

To add typed text, click where you want the text to appear and begin entering text. Don’t 
be too concerned if you decide to change the layout later. You can move your notes around 
on the page whenever you want.
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To format your text, select the text you want to format and use the formatting tools on the 
Home tab of the ribbon or on the Mini Toolbar that appears just above the selected text. 
You can apply various font colors, font sizes or types, effects like Bold or Underline, and also 
highlights to your text.

OneNote makes a basic set of Styles that you can use to format your notes. To apply a style, 
select the text you want to apply the style to, and then select the style you want to apply 
from the Styles gallery on the ribbon.

TIP  The styles in OneNote 2013 can’t be customized, and you can’t create your own style. 
You’re limited to the predefined styles that are included with the product.

Inserting images
There are a number of ways you can insert images into your notes in OneNote 2013. First, 
select the note page where you want the image to appear. Then use one of the following 
techniques to insert your image:

▪▪ On the Insert tab, click Pictures to select an image from your hard drive or Online 
Pictures to search online sources for an image or piece of clip art to insert.

▪▪ On the Insert tab, click Screen Clipping to use the Screen Clipping tool to select and 
insert a portion of your screen. This is great for inserting images of error messages or 
other on-screen content.

▪▪ If you have a scanner connected to your computer or device, you can click Scanned 
Image on the Insert tab to insert an image from your scanner.

▪▪ In some cases, you can drag images from other applications right into your notes.

▪▪ You can press the Windows logo key+N to open the Send to OneNote tool, then 
press N again to start a screen clipping action. Select a section of the screen you want 
to clip, and then paste it into your notes.
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SEE ALSO  We’ll talk more about screen clipping in Chapter 35, “Getting better results 
with less work.”

▪▪ After you’ve inserted an image into OneNote, you can move it to wherever you would 
like it to appear on the page. Just drag the image to place it. You can also resize the 
image by dragging one of the image’s handles that appear at the sides and corners of 
the image when you select it.

Working with ink and shapes
OneNote was originally created to be the “killer app” on the original tablet PCs. Back in 
the early 2000s, Microsoft got on board to promote a variant of the laptop computer that 
had a touch screen. Some were laptops where the screen could lie flat; these were called 
convertibles. Others had screens that detached entirely from the keyboard, much like early, 
primitive, iPads. These were called slates. The devices ran a version of Windows that was 
designed specifically for tablets, and OneNote (then OneNote 2003) was a powerful tool 
for those early efforts at tablet computing. Though those tablets never really took off, 
OneNote has endured and thrived, and the ink capability of those early devices has contin-
ued in OneNote.

In this exercise, you’ll explore the inking capabilities of OneNote.

	SET UP  You don’t need any practice files to complete this exercise. Just open One-
Note and open a blank page that you can practice drawing on.

1	 Click the Draw tab.

2	 On the Draw tab, in the Tools group, you’ll find a selection of pen colors and thick-
nesses. Click one of the pens from the pen gallery to select it, or click the More but-
ton on the right edge of the gallery to expand it and show more pen choices.
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3	 After you’ve selected a pen, click in the page area. Then draw, write, or annotate with 
that pen, using your mouse or a stylus. 

4	 To change back to entering text, click the Type button at the left end of the Draw 
tab.

+ 	CLEAN UP  Delete the practice drawing page if you want to.

678      Chapter 25  Working with notebooks, sections, and pages



Custom pens
If you can’t find the pen you want, you can create a custom pen by clicking the Color & 
Thickness button in the middle of the Draw tab. 

Shapes
Next to the Color & Thickness button you’ll find the Shapes gallery. These shapes may look 
like the kind of shapes you’re used to in other applications, but actually, they’re just pre-
defined ink strokes. That’s important to understand, because you use the pens gallery to 
select the color and thickness of the lines in your shape.

To create a shape, select the pen you want to use from the pens gallery, and then select 
the shape you want to draw from the shapes gallery. Use your mouse or stylus to drag the 
shape onto the page where you want it to appear.

Didn’t get it exactly the right size or precisely where you want it? Just drag and drop the 
shape where you want it or grab one of the resizing handles and make the shape larger or 
smaller.
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If you want multiple copies of the same shape, select your shape, click Copy (or press 
Ctrl+C), then move to another part of the page and click Paste (or press Ctrl+V). You can 
make as many copies of the same shape as you like, then drag those shapes to various 
places on the page.

If you want to select multiple shapes and move them as a group, you should use the Lasso 
Select option. Click Lasso Select button on the Draw tab and draw a line around the shapes 
you want to select. When you’ve completed the loop, OneNote will select all of the items 
within that Lasso. Then you can drag the shapes or delete the group as you choose.

If the shape isn’t aligned the way you’d like, you can rotate it to the right or left. Select your 
item and click Rotate on the Draw tab (or right-click the shape and select Rotate from the 
shortcut menu) to display more choices for how you can rotate the shape.
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Erasing ink or shapes
If you don’t like what you’ve drawn, you can use a couple of methods provided by OneNote 
to erase it. The first way, if it’s something you just drew, is to simply use Undo (press Ctrl+Z). 
You can undo several steps in case you wish to go back further than one step. Just continue 
pressing the key combination until you’ve removed the steps you don’t want. 

If you accidentally undo one too many steps, you can use Redo (press Ctrl+Y) to advance 
one step.

If you want to do a somewhat more determined sculpting of your ink, you can use the 
Eraser tool on the Draw tab. When you click the Eraser tool, the pointer turns into an eraser 
that you can use to erase ink or shapes (or parts of them) from your page.

TIP  The eraser can be used to erase parts of drawings but not of inserted images.

You have four different types of erasers to choose from. To select one, click the arrow below 
the Eraser button to view the menu.

The types of erasers are described in the following list.

▪▪ Small Eraser  An eraser with a small head for very fine work.

▪▪ Medium Eraser  An eraser that is a bit bigger than the small eraser; used for faster 
erasing.

▪▪ Large Eraser  A rather large eraser head; used for wiping large swathes of the page in 
quick strokes.

▪▪ Stroke Eraser  A special eraser that removes entire ink strokes with a single click. This 
eraser is useful for quickly removing a specific ink stroke without disturbing other ink 
around it.
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Inserting space
Sometimes you’ll want to move items down the page so that you can insert other items 
above them. The Insert Space tool helps you do that. Just point above the items you want 
to move down, click the Insert Space button on the Draw tab, and drag down to move all of 
the items below that point down.

Insert space

You can also insert space horizontally with the Insert Space tool. Simply point to the side of 
the page; the Insert Space line will change from a horizontal line to a vertical line. Then you 
can drag left or right to move everything over.

TIP  The Insert Space button can also be used to remove space. If you have some blank 
space in your page and you want to move everything below that space up, point above the 
items you want to move up, click Insert Space, and drag up to remove the excess space.

To illustrate how this works, enter some text on the page. Then enter some text in a differ-
ent note container that appears somewhat lower on the page. Next, click Insert Space on 
the Draw tab, and point to the space between those two note containers. Then drag down 
to insert more space between them.
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Arranging shapes
Shapes don’t only exist in two dimensions in OneNote. You can also layer them front to 
back, and for that you use the Arrange tool.

To place a shape in front of another shape, select that shape, click the Arrange tool on the 
Draw tab, and select Bring To Front. 

After you’ve brought the shape to the front, drag it on top of the shape you want it to be in 
front of. In the following graphic, you can see that the Arrange tool has been used to bring 
the photo of the dog in the crate to the front of the image, and send the other dog photo 
to the back. Then the front photo was moved so that it overlaps the back photo.

If you play around with the Arrange features, you’ll find that you can create some complex 
layers of shapes.

25

	 Working with ink and shapes      683



Recovering deleted sections or pages
If you’ve deleted a page or section and want to get it back, then the Notebook Recycle Bin 
is your friend. 

Following are the steps for restoring deleted sections or pages.

1	 On the History tab, click the Notebook Recycle Bin button , and then select Note-
book Recycle Bin from the menu that appears. OneNote displays deleted pages or 
sections it still has from the current notebook.

2	 To restore a section or page, right-click the tab for the section or page, choose Move 
or Copy, and move it back to where you’d like it in the notebook.
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TIP  You can also drag to move deleted pages from the Notebook Recycle Bin back to 
the regular notebooks.

3	 If you’re sure that you don’t need anything in the Recycle Bin, you can empty it to 
save a little bit of space. Just click Notebook Recycle Bin on the History tab. Then 
select Empty Recycle Bin from the menu.

Key points
▪▪ OneNote 2013 uses notebooks, sections, and pages to help you organize your notes. 

You can have as many notebooks as you like, each containing one or many sections. 
Each section can contain one or many pages.

▪▪ You can move pages and sections between notebooks.

▪▪ On a page, you can take notes with text, images, ink, shapes, or other kinds of 
content.

▪▪ Ink and shapes are drawn with pens, which can have many different colors or 
thicknesses. 

▪▪ Ink and shapes can be moved, resized, or rotated as needed. 

▪▪ OneNote’s eraser provides several options for cleaning up any mistakes.

▪▪ If you accidentally delete a section or page, it can be recovered from OneNote’s 
Notebook Recycle Bin.
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Index

Index

Symbols
0 (zero), as Excel formatting code,  554
1 Page per Sheet print option,  246
2-D vs. 3-D charts in presentations,  318
3-D charts,  629
3-D effects, applying to shapes,  346–349
3-D Format tools, in Format Shape pane,  346
3-D vs. 2-D charts in presentations,  318
$ (dollar) sign, in Excel formulas,  467–470, 493
* (asterisk), in Excel formatting,  554, 569
@ (at symbol), as Excel formatting code,  555
[ ] (brackets)

adding to formatting code in Excel,  558
as Excel date formatting code,  570

^ (caret), entering from keyboard,  168
: (colon), entering from keyboard,  168
, (comma)

as Excel formatting code,  555
using in custom number format code,  635

= (equal) sign, in Excel formulas,  452
# (pound sign), as Excel formatting code,  554
“ ” (quotation marks)

as Excel formatting code,  555
using in searches,  710

=Rand(),  85
~ (tilde), entering from keyboard,  168
_ (underscore), as Excel formatting code,  554

A
accent colors,  274–275

Accessibility Checker pane
in PowerPoint,  393
in Word,  237

Account page
connecting to cloud service,  79–81
switching to another Office account,  76–77

Account page, Backstage,  12–13
Add a Digital Signature option,  574
adding

commands to Quick Access Toolbar,  28–29
frames to images,  359
sections,  380–383
shapes in PowerPoint,  336–341
text boxes to slides,  308–313
text to slides,  304
timelines to charts,  637–639

Add To Quick Access Toolbar command,  28–29
adjustment handles, using,  349–351
After spacing option, in Paragraph dialog box,  288
aligning

objects button,  640, 645
objects in PowerPoint,  289, 340
text using tabs,  214
using alignment guides,  127
using Smart Guides in PowerPoint,  289, 311, 352

Align Objects button,  640–641, 645
All Caps font format option,  201
Also Insert From YouTube icon,  374
Always on Top option, OneNote,  664
am/pm (a/p), Excel date formatting code,  570
AND() functions,  476
Android, sharing notes via SharePoint on,  723
Android, using OneNote on,  743–745
Animation gallery,  366
Animation Painter, in PowerPoint,  369
Animation pane, PowerPoint,  368–370
animations

number next to,  369
playing one at a time,  370
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reordering,  370
Animations tab, PowerPoint

Effect Options on,  367
Fade command on,  366

application Start screen
about,  4–5
templates in,  58

application window, elements in,  6–13
Account commands,  12–13
dialog box launcher,  8
galleries,  8–9
KeyTips,  11
Live Preview,  9
Mini Toolbar,  10
Quick Access Toolbar,  8
ribbon,  6
Screen Tips,  10–11
status bar,  8
title bar,  7
tool tabs,  8

appointments, connecting to OneNote,  695–697
Apps for Office, inserting in Office documents,  47
Arrange All button,  612, 621
Arrange button,  360
Arrange group, Align Objects button in,  640–641
Arrange tool, OneNote,  683
Artistic Effects button,  357
asterisk (*), in Excel formatting,  569

in Excel formatting,  554
at symbol (@), as Excel formatting code,  555
audio. See also video

linking files to PowerPoint,  371
playing across slides,  373
recording with OneNote,  755–756
searching notes in OneNote for recordings,  708

Audio Tools Playback tab,  373
AutoComplete ScreenTip,  179–180
AutoCorrect

deleting entries that were added in error,  175
entering symbols using,  167–168
using,  172–175

AutoCorrect dialog box,  173–174, 211
AutoCorrect Options button,  520
autofill

extending series with,  429–431

suppressing,  431
AutoFill Options menu, in Excel,  429
AutoFit to contents option, in Insert Table dialog 

box,  219
AutoFit to window option, in Insert Table dialog 

box,  219
AutoFormat As You Type feature

for numbering and bulleting lists,  210
turning off,  210

Auto-hide Ribbon option,  7–8
auto-hide state, setting ribbon to,  27
AutoRecover information, turning on,  23
autosave files, setting feature to,  23–24
AutoSum button,  457–460
Available Windows area of menus,  651
AVERAGE() function,  460–461
Axes option, in Chart Elements list,  636

B
Background Removal tab,  361
backgrounds

applying styles to presentations,  281–283
playing audio file in presentations,  373
preferred setting for,  12
removing from pictures in PowerPoint,  361–363

Background Styles menu choice, in 
PowerPoint,  282

Backstage pages
Account,  12–13, 76–77, 79–81
Export,  22
Info,  16–17, 23–25
New,  17–19
Open,  20, 91
Print,  21–22
Save As,  21, 86–87
Share,  22, 88–89
Sign in to Office,  74

Backstage view
closing,  13
displaying,  11

Before spacing, in Paragraph dialog box,  288
Bezier Curves,  351
Bing, searching from Research pane using,  152
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Blank layout, in PowerPoint,  343
Blank Workbook, creating,  424
Blur field, in Format Shape pane,  345
body fonts, in PowerPoint,  272
bolding selected text,  310
Border button, in Excel,  425
borderless tables,  226
Border Painter command, in Word,  125
Border Painter, in Word,  125
Border Sampler command,  224
Border Sampler, in Word,  125
borders, removing from shapes,  345
Border Styles gallery

for tables in Word,  125
on Table Tools Design tool tab,  224

bottom page margins, toggling in Print Layout 
view,  120

brackets ([ ])
adding to formatting code in Excel,  558
as Excel date formatting code,  570

Bring to Front menu option
in OneNote,  683
in PowerPoint,  360

browser, accessing notes in,  738–740
building blocks

composing documents using,  176–180
in Word,  128

Building Blocks Organizer dialog box,  180
built-in functions

AVERAGE,  460–461
SUM,  460–461
using,  460–462

bulleted lists
about,  209
formatting,  210–213

bullet points
changing list text into SmartArt graphic,  321–325
changing size and color of,  285
changing spacing before and after paragraph 

levels of bulleted text,  288
creating second level bulleted text in slides,  308
troubleshooting slide,  306

Bullets gallery, in PowerPoint,  286
buttons

Align Objects,  640–641, 645

Animation pane,  368
Arrange,  360
Arrange All,  612, 621
Artistic Effects,  357
AutoCorrect Options,  520
AutoSum,  457–460
Border, in Excel,  425
buttons,  356
Cell Styles,  542–545
Change Chart Type,  627–628, 633
Chart Elements,  627, 632, 633, 636
Chart Styles,  626–627, 632
Collapse Field,  533
Color,  344, 362
Comma Style,  539
Conditional Formatting,  505, 506
Convert To Range,  521, 587
Convert to Shapes,  110
Create PDF/XPS,  239
Crop,  356
Data Validation,  488
Decrease Decimal,  461
Decrease Font Size,  285
Decrease List Level,  306
Dock to Desktop,  663
“epsilon”,  457–460
Field Buttons,  627
Fit Slide to Current Window,  289
Freeze Panes,  592
From Beginning or From Current Slide,  397
Group Objects,  649
Help,  7
hiding filter,  516
Increase Font Size,  285
Increase List Level,  306, 307
Ink Comment,  109
Insert Function,  464–467
Insert Slicer,  630
Insert Space,  682
Insert Timeline,  638
Layout, in PowerPoint,  336
Layout Options, in Word,  127
Linked Contact Notes,  697
More Options,  319
New Slide,  305, 313–316
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Next,  137
Notebook Recycle Bin,  684–685
Orientation,  604
Outlook Tasks,  698
Page Templates,  765
Pictures,  51
Previous,  137
Print,  22
Protect Workbook,  573
Publish,  242
Recents, OneNote Mobile apps,  743
Remove Background,  361–362
Remove Gradient Stop,  345
Reset Picture,  359
Ribbon Display Options

in Excel,  413, 575
in Office,  7–8
in PowerPoint,  256
in Word,  118

Rule Lines,  661–662
Running Total,  504
Save, green arrows on Quick Access Toolbar,  91
Screenshot,  355, 651
See All Slides,  397
Select All, in Excel,  443
Send Backward,  645
Set As Default, in Find Options dialog box,  140
Shape Effects,  642
Shape Fill,  343
Shape Options Effects,  345
Shapes,  643, 645
Show/Hide ¶,  163, 201, 215
Slicer,  637
Slide Master,  272
SmartArt,  52
Start Inking,  108
Symbol,  165–166
Symbol, OneNote,  691
Synchronous Scrolling,  578
Text Effects,  348, 646
Text Highlight Color,  187
Themes,  49, 549
Timeline,  638–639
Touch Mode,  103
Trim Video,  372

Undo,  156
using,  502
Values

in Paste Special,  486
in Paste Values group,  485

View Side By Side,  578
What-If Analysis,  501
Window control

in Excel,  413
in Office,  7–8
in PowerPoint,  256
in Word,  118

Wrap Text,  444
Zoom,  652
Zoom to Page,  389

C
Capitalize each word option,  202
caret (̂ ), entering from keyboard,  168
case of text, changing in Excel,  485–487
Category Name option, of Format Data Labels task 

pane,  634
cell ranges, selecting and naming 

spreadsheet,  434–437
cell references vs. static values in formulas,  457
cells, spreadsheet

copying and pasting range of,  485
copying one or more cells to many,  447–448
creating bottom border in,  425
extending series with autofill,  429–431
finalizing entry in,  424
format for email and web addresses,  432
formatting,  426–427, 550–551
maximum number of characters in,  442
maximum number of rows,  458
moving and adjusting,  442–444
pasting formulas as resulting values,  484–485
restricting entries in,  487–492
using references,  467–470
validating entries,  470–472
working with text in

changing case of text,  485–487
combining into one string,  479–482
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pasting formulas as resulting values,  484–485
removing extra spaces,  482–484

Cell Styles button,  542–545
Centered Overlay option, in Chart Title option 

list,  636
centering text,  316
Change Case command,  202–203
Change Chart Type button,  627–628, 633
Change Chart Type dialog box,  627–628
Change File Type option,  243
changing

bulleted list text into SmartArt graphics,  321–325
bullet size or color,  285
case of text in Excel,  485–487
font size,  285
Office Theme,  12
permissions on shared files,  90
presentation to widescreen format,  297–300
search scope in,  709–710
spacing before and after paragraph levels of 

bulleted text,  288
widths of columns,  423–426
widths of spreadsheet rows,  426

character formats
exploring,  200–201
resetting,  196
using styles for,  192–196

characters, international,  167–168
Chart Elements button,  627, 632, 633, 636
chart elements, double-clicking,  636
Chart Elements list

Axes option in,  636
Chart Title option in,  636

Chart Elements list, seeing icons next to,  318
Chart Filters tool (funnel icon),  320
charts

adding slicers to PivotCharts,  629–632
adding timelines,  416, 637–639
creating and modifying,  623–629
formatting,  43–44
inserting in Office documents,  54
inserting in PowerPoint,  316–320
manipulating elements in,  632–637
manipulating objects in,  640–642
Recommended Chart feature,  415

viewing in Read Mode,  147
Chart Styles button,  626–627, 632
Chart Title option, in Chart Elements,  636
Chart Tools Design tool tab,  57
circular text, making,  348
CLEAN() function,  476
Clear Filter command,  518
Clear Formats option,  546
cloud services. See also Office cloud accounts; See 

also SkyDrive
about,  71–73, 78–79
changing permissions,  90
computer requirements to access,  72
connecting to,  79–81
Office 365,  83
opening files from,  42, 90–91
personal,  80–81
saving files on,  42, 85–87
sharing files from,  88–90
signing into Office cloud account,  74–76
syncing files for offline use with,  92–96

Clustered Column thumbnail,  624–625
co-authoring Office documents,  97–98
Collapse All Headings option,  143
Collapse Field button,  533
collapsing ribbon,  27
Collated print option,  246
colon (:), entering from keyboard,  168
Color button

in Format Shape pane,  344
under Picture Tools Format tab,  362

colors
changing bullet color,  285
Create New Theme Colors dialog box,  282
customizing PowerPoint,  273–275
Sort by Color/Filter by Color commands,  518
theme vs. direct,  341–342
using absolute,  276

Colors dialog box, in PowerPoint,  279
column headers, in Excel, using in defining 

names,  437–439
COLUMN([reference]) functions,  478
columns

changing widths of spreadsheet,  423–426
deleting OneNote table,  707
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deleting Word table,  222–223
inserting in Excel,  583–587
moving and copying spreadsheet,  445–446
printing column labels in Excel,  599–602

COLUMNS(array) functions,  478
Column Width, as Read Mode option,  145
comma (,)

as Excel formatting code,  555
using in custom number format code,  635

commands
Account,  12–13
adding commands from Quick Access Toolbar

in Excel,  412
in Office,  28–29
in OneNote,  659
in Word,  118

Border Painter command in Word,  125
Border Sampler,  224
Change Case,  202–203
Clear Filter,  518
Control AutoCorrect Options,  520
Create From Selection

in Defined Names group,  470–471
in Excel,  437–439

Date Filters,  519
Define and Translate,  152
Draw Table,  219
Excel worksheets Hide,  611
file tab, Excel,  412
Filter by Color command,  518
Filter menu,  518–519
Flash Fill, in Excel,  431–433
Freeze Panes,  592
keyboard access to,  546
Lock Cell,  491
Number Filters,  519
Page Width,  120
Print Titles,  599, 602
Remove Split,  123
removing commands from Quick Access 

Toolbar,  28–29, 118
ribbon vs. Quick Access Toolbar,  32
screen tips for,  10–11
Scroll Here,  135
Sort,  518

Sort by Color,  518
split control on ribbon of,  6–7
Stop Automatically Expanding Tables,  520
Text Filters,  519

Comma Style button,  539
comment indicator, in Word,  126
Compare Side by Side dialog box,  619
Compatibility Checker, PowerPoint,  394
Compatibility Mode, in Word,  129
composing documents

inserting special characters,  169–171
inserting symbols,  165–166, 168
using AutoCorrect,  167–168, 172–175
using building blocks,  176–180
using formatting marks in,  161–164
using international characters,  167–168

Compress Pictures dialog box,  358
Computer & HD Displays option,  376
CONCATENATE() function,  476, 479–482
Conditional Formatting button,  505
conditional formatting features,  504–507
contacts, annotating contacts in OneNote,  697–

698
Continuous section breaks,  191
Control AutoCorrect Options,  173
Control AutoCorrect Options command,  520
Convert Text to Table dialog box,  219–220
Convert To Range button,  521, 587
Convert to Shapes button,  110
copying

columns and rows on spreadsheets,  445–446
formulas,  452–456
formulas and pasting as resulting values,  484–485
one or more spreadsheet cells to many,  447–448
range of cells,  485

copying selected text or object,  311
Copy Link to Page option, OneNote,  700
Copy Link To Paragraph option, OneNote,  702
COUNTIF() functions,  474
Count Numbers function,  462
Create a Video setting,  376
Create From Selection command

in Defined Names group,  470–471
in Excel,  437–439

Create Graphic group,  323
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Create New Building Block dialog box,  178
Create New Theme Colors dialog box,  282
Create PDF/XPS button,  239
Create PDF/XPS Document option,  241
creating

blank document,  179
bottom border in spreadsheet cells,  425
charts,  623–629
coordinating documents across applications,  128
creating notebooks on SkyDrive,  713–716
creating notes in OneNote Mobile apps,  743
custom shapes,  349–354
custom slide layouts,  291–297
custom sort list,  523–526
custom themes in Excel,  546–549
formulas,  452–456
graphics in Excel,  642–648
hyperlinks to pages in OneNote,  702–704
new files,  17–19
notebooks,  670–671
OneNote tables,  704–707
pages in OneNote,  675
PDFs

in OneNote,  666
in PowerPoint,  389
in Word,  239–244

perfect shapes,  336
PivotTables,  526–533
presentations using theme variants,  268
sections in OneNote,  671–673
tables in Word,  217–223
tags, OneNote,  690–692
theme font set,  277

Crop button, from Picture Tools Format tab,  652
cropping pictures, in presentations,  356
cursor

keyboard shortcuts for moving,  155–156
moving to beginning of sentence,  171

Custom category, of Format Cells dialog box,  634–
635

Customize Quick Access Toolbar list,  27
Customize Status Bar list,  30–31
Customize Status Bar menu,  462
Customize Status Bar options,  191
customizing

PowerPoint fills,  342–349
PowerPoint themes,  271–276
Quick Access Toolbar,  28–29
ribbon,  32–35
shapes,  349–354
slide layouts,  291–297
status bar,  30–31
user interface,  25–31

custom keyboard shortcut, assigning to character 
or symbol,  168

custom number format code, using comma (,) 
in,  635

Custom Print option,  247

D
data, Excel

adding to tables,  519–521
analyzing from outside source,  508–511
entering and organizing data,  422–423
formatting,  426–429
sorting,  521–523

data labels,  44
Data Labels option, in Chart Elements,  627, 633
data model, Excel,  512, 534
Data Tools group, in Excel, Flash Fill command 

in,  431–433
Data Validation dialog box,  488, 492
Date Filters command,  519
date formats, Excel,  564–570
date() function,  477–478
d (Day), Excel date formatting code,  569
decimal tabs,  214, 220, 226
Decrease Decimal button,  461
Decrease Font Size button,  285
Decrease List Level button,  306
default formatting, setting for documents,  128
Define and Translate commands,  152
Defined Names group, Create From Selection 

in,  470–471
Define Name command, in Excel,  435
Define option, as research tool,  149
deleting

AutoCorrect entries that were added in error,  175
cells in Excel,  587–591
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custom color theme in PowerPoint,  280
decimal tabs,  220
Word tables,  222–223

demoting text in slides,  306
Design tab

in PowerPoint,  270, 272, 277, 282, 299
in Word,  128

diagrams. See charts
dialog box launcher,  8
dictionary

adding words to,  232
definitions and synonyms,  152

direct colors vs. theme colors,  341–342
Dock to Desktop button,  663
Dock to Desktop view, OneNote,  660
Document Inspector

in PowerPoint,  392–393
in Word,  234–237

documents
alignment guides in,  127
collapsible headings,  126
collapsing and expanding headings in,  141–144
composing

inserting special characters,  169–171
inserting symbols,  165–166, 168
using AutoCorrect,  167–168, 172–175
using building blocks,  176–180
using formatting marks in,  161–164
using international characters,  167–168

correcting proofing errors,  230–232
created in earlier versions of Word,  129
creating across applications coordinating,  128
editing

PDFs,  124
selecting text,  156–160

formatting
about,  183–188
changing case of text,  200–201
exploring character,  200–201
exploring paragraph,  196–198
managing pagination through,  203
setting default documents,  188
setting section formatting,  190–192
using styles for,  192–196

heading styles in,  141–144

inspecting before publishing,  233–237
making final,  238
navigating,  135–141
opening from Internet,  148
PDFs

creating,  239–244
editing,  239, 243–244

presenting information in
enhancing tables,  223–227
inserting tables,  217–223
using bulleted lists,  209, 210–213
using numbered lists,  209, 210–213
using tabbed lists,  210, 213–217
using tables,  210

printing,  245–249
printing documents,  245
Read Mode

exploring research tools in,  148–152
viewing documents in,  144–148

scrolling,  134–135
searching,  135–141
setting default formatting for,  128
tables in,  125
threaded comments in,  126
tracking changes in,  126
using tables for page layouts,  226
views in,  119–122

.docx file extension,  116
dollar ($) sign, in Excel formulas,  467–470, 493
double-clicking, chart elements,  636
double quotes (“), as Excel formatting code,  555
Double Strikethrough font format option,  201
Draft view

in Word,  120
opening documents in,  122

dragging
animations into Animation pane,  370

Drawing Tools Format tab
Align button from,  645
Align Objects button from,  640–641
formatting illustrations using,  52
Group Objects button from,  649
Merge Shapes tool from,  353
Send Backward button from,  645
Shape Fill button from,  343
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Shape Styles from,  337
Shape Styles palette from,  644
WordArt Styles group in,  646

Draw Table command,  219
duplicating objects,  311

E
Edit Document, as Read Mode option,  145
editing

custom color theme in PowerPoint,  280
documents,  155–156
formulas,  452–456
PDFs,  124, 239, 243–244
saved slide show presentations,  401
video,  371–373

Edit mode, activating formula,  469, 481, 493
Edit Points, in PowerPoint,  351
Effect Options in PowerPoint

Animations tab in,  367
effects

applying enhanced fills and,  342–349
customizing PowerPoint theme,  277–281

email addresses
Excel format for,  432
selecting in Excel,  435

email messages
sending notes via,  728–729
sending to OneNote,  693–695

em and en spaces, formatting marks for,  170
embed codes, in videos,  374–375
Emphasis animations,  368
empty paragraphs,  162
Encrypt with Password option,  573
enhanced fills, applying in PowerPoint,  342–349
Entrance animations,  368
“epsilon” button, using,  457–460
equal (=) sign, in Excel formulas,  452
eraser, OneNote,  681
error messages, chart,  318
Even Page or Odd Page section breaks,  191
EXACT() function,  476
Excel

about,  421–422

about new features in,  417–418
about starting,  409–413
adding data to tables,  519–521
analyzing data from outside source,  508–511
cells in

changing case of text,  485–487
copying and pasting range of,  485
copying one or more cells to many,  447–448
deleting,  587–591
extending series with autofill,  429–431
format for email and web addresses,  432
formatting,  426–427, 550–551
inserting,  587–591
maximum number of characters in,  442
moving and adjusting,  442–444
pasting formulas as resulting values,  484–485
restricting entries,  487–492
using references,  467–470
validating entries,  470–472
working with text,  479–487

changing widths of spreadsheet columns,  423–426
charts

adding slicers to PivotCharts,  629–632
adding timelines to,  416, 637–639
creating and modifying,  623–629
manipulating objects in,  640–642

conditional formatting features,  504–507
creating and sharing graphics in,  642–648
creating custom sort list,  523–526
custom formatting codes,  554–555
data model,  512, 534
entering and organizing data,  422–423
filtering data with tables,  512–518
Filter menu commands,  518–519
Flash Fill command in,  413, 431–433
formatting cells,  550–551
formatting data,  426–429
formatting worksheets

applying number formatting,  538–541
applying percentage format to numbers,  558–

560
Clear Formats option,  546
creating custom themes,  546–549
custom number formats,  551–558
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lining up positive and negative numbers in 
columns,  541

protection in,  570–572
setting view options,  574–578
with styles,  542–545
working with dates,  564–570
working with fractions,  560–564

formulas
about,  452
activating Edit mode,  469, 481, 493
dollar ($) sign in,  467–470, 493
entering,  452–456
equal (=) sign in,  452
static values vs. cell references,  457
using cell references,  467–470
using Formulas tab,  473–479
using names in,  470–472

functions
CONCATENATE(),  476, 479–482
date,  477–478
financial,  478–479
inserting,  464–467
logical,  475–476
math and trig,  474–475
PROPER(),  476, 486
reference,  478
text,  476–477
time,  477–478
TRIM(),  477, 483
using,  456–457
using AutoSum button,  457–460
using AVERAGE() function,  460–461
using status bar for checking totals,  462

graphics in
creating and sharing,  642–648
using in other Office Applications,  648–653

inserting columns and rows,  583–587
inserting spreadsheets in OneNote,  763–764
jumping to first cell in worksheet,  520
manipulating elements in charts,  632–637
moving and copying columns and rows,  445–446
moving around worksheets,  439–441
online pictures feature in,  45
page layout options,  591–599
pages in

adjusting page breaks,  602–606
printing row and column labels,  599–602

panes,  591–599
performing What-If Analysis,  498–502
PivotTable Fields pane,  528
PivotTables. See also PivotTables

creating,  526–533
Recommended PivotTables feature,  415, 527
recovering unsaved files in,  24
Scenario Manager,  499
selecting and naming cell ranges,  434–437
sheet references in,  617–618
Simple to-do list workbook in,  49
sorting data,  521–523
table slicers,  415
templates

built-in,  495–498
storing formats in,  579–580

using column headers in defining names,  437–439
using Quick Analysis,  502–504
using touch mode in,  105
values in,  426, 429
workbooks

changing number of sheets setting in,  417
creating multisheet,  606–610
displaying separate windows,  414
managing multiple,  618–621
manipulating sheets in,  610–613
summarizing multisheet,  613–616

Zoom group,  603
exercise steps in book, adapting to,  26
Exit animations,  368
Expand/Collapse heading option,  143
expanding ribbon,  27
Export command, in Excel,  412
exporting

OneNote to other formats,  730–732
Export page

about,  22
OneNote,  666

Eyedropper menu choice,  339–340
Eyedropper Text Fill tool,  263, 340
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F
Facebook, connecting to personal cloud service 

in,  80–81
Fade, PowerPoint,  366
Field Buttons button,  627
Field List, PivotTable,  418
files. See also Office documents

changing permissions,  90
creating new,  17–19, 60
customizing PowerPoint,  271–276
opening,  20
opening from cloud,  42, 90–91
pinning and unpinning,  20
recovering unsaved changes to,  23–25
saving as PDF,  22
saving in XPS format,  22
saving on cloud service,  42
selecting multiple,  107
setting feature to autosave,  23–24
sharing files from cloud service,  88–90
syncing for offline use with SkyDrive,  92–96
viewing information about active,  16–17
viewing recent files,  20

file server
sharing notes on,  718–723
stop sharing on,  721–723

File tab
Excel,  412
OneNote,  658
PowerPoint,  255
Word,  118

Filled Round Bullets menu choice,  286
Fill menu, in Excel, Flash Fill command from,  431
filter buttons, hiding,  516
Filter by Color command,  518
Filter group; a dialog box,  630
Filter menu commands,  518–519
financial functions,  478–479
Find Options dialog box,  140
Fit Slide to Current Window button,  289
Fixed Column Width option, in Insert Table dialog 

box,  218
Flash Fill command, in Excel,  413, 431–433
folders, pinning and unpinning,  20
Followed Hyperlink color, in PowerPoint,  280

Font dialog box,  200
fonts

creating theme font set,  277
customizing PowerPoint,  271–276
decreasing font size,  285
glyph,  166
increasing font size,  285
serif and sans serif,  188

Font Size box, PowerPoint,  285
Format Background pane, in PowerPoint,  290
Format Cells dialog box,  561–563, 565–567

Custom category in,  634–635
using comma (,) in custom number format 

code,  635
Format Chart Title task pane,  625
Format Data Labels task pane,  634
Format Shape pane,  258

3-D Format tools,  346
accessing,  344
Blur field,  346
in Excel,  646–648
Shape Options Effects button in,  345

formatting
accessing PowerPoint picture formatting tools,  358
cells in Excel,  426–427
changing presentation to widescreen format,  297–

300
charts

controlling,  43–44
in PowerPoint,  316–320

conditional,  504–507
data in Excel,  426–429
documents

about,  183–188
changing case of text,  200–201
exploring character formatting,  200–201
exploring paragraph formatting,  196–198
managing pagination through,  203–207
setting default documents,  188–190
setting section formatting,  190–192

illustrations using Drawing Tools Format tool 
tab,  52

in OneNote using styles,  692–693
lists using bullets,  210–213
lists using numbering,  210–213
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manual text boxes in slides,  308–313
OneNote with templates,  765–767
options in all galleries,  273–275
pictures in presentations,  354–360
placeholders on slide master,  283–288
reusing slides and keeping source,  326–333
setting for documents default,  128
shapes in PowerPoint,  336–341
table borders in,  125
tables in PowerPoint,  313
Total Row,  223
worksheets

applying number formatting,  538–541
applying percentage format to numbers,  558–

560
cells,  550–551
Clear Formats option,  546
creating custom themes,  546–549
custom number formats,  551–558
formatting with styles,  542–545
lining up positive and negative numbers in 

columns,  541
protecting,  570–572
setting view options,  574–578
working with dates,  564–570
working with fractions,  560–564

formatting marks
using during document composition,  161–164

formulas. See also functions
about,  452
activating Edit mode,  469, 481, 493
creating,  464–467
dollar ($) sign in,  467–470, 493
entering,  452–456
equal (=) sign in,  452
inserting,  464–467
pasting as resulting values,  484–485
static values vs. cell references in,  457
using cell references,  467–470
using Formulas tab,  473–479
using names in,  470–472
using status bar for checking totals,  462

Formulas tab, in Excel
about,  473
Create From Selection command on,  437–439

Defined Names section on,  435
Fragment tool, PowerPoint,  264
Freeform icon,  351
Freeze Panes command,  592
From a Video Embed Code field,  375
From Beginning or From Current Slide buttons,  397
Full Page view, Notebook,  660
Full Screen mode

OneNote,  665
vs. Read mode,  119

Function Arguments dialog box,  465–466, 473
Function dialog box,  473
functions. See also formulas

about,  456–457
AVERAGE,  460–461
CONCATENATE(),  476, 479–482
Count Numbers(),  462
date,  477–478
financial,  478–479
inserting,  464–467
logical,  475–476
math and trig,  474–476
Max(),  462
Min(),  462
PROPER(),  476, 486
reference,  478
text,  476–477
time,  477–478
TRIM(),  477, 483
using,  456–457
using AutoSum button,  457–460
using AVERAGE() function,  460–461
using Formulas tab,  473–479
using status bar for checking totals,  462

funnel icon (Chart Filters tool),  320

G
galleries

about,  8–9
Animation,  366
Border Styles,  224
Bullets,  286
Bullets and Numbering,  211–212
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Reuse Slides,  326–333
Rule Lines,  662
Shapes,  679–680
SmartArt Styles,  324
Styles

Excel,  542
Word,  184

Table Styles,  223
Tags,  688–689, 752
Theme,  270
Theme Colors,  278, 280
Theme Font,  272
Theme Fonts,  277
Themes,  49, 549
Variants,  270, 277

gestures
in touch mode,  105–106
zoom on slide in touch-enabled device,  400

Get a Sharing Link option,  46
Get External Data group,  508
glyph fonts,  166
Goal Seek command,  499, 502
Goal Seek dialog box,  499, 501
gradient fills, applying and editing,  342–349
grammar errors

correcting,  230–231
correcting in touch mode,  105

graphics. See also illustrations; See also pictures 
(photos)

adding to presentations,  288
copying to slides,  290, 341–342
creating and sharing in Excel,  642–648
distortion changing to presentation wide-screen 

format,  300
using between Office applications,  648–653

Gridlines option, in Excel,  636
grouped worksheets, Excel,  610
Group Objects button,  649
guides

document alignment,  127
in PowerPoint,  311

H
handwriting recognition vs. ink,  108
hanging indent markers,  198, 214
HD Displays option, Computer &,  376
heading fonts, in PowerPoint,  272
headings in documents

collapsible,  126
collapsing and expanding,  141–144
styles of,  141–144

Headings section, in Navigation pane,  137
heading text,  185
Help button,  7
h (Hour), Excel date formatting code,  570
hidden text

font format option,  201
printing,  201

Hide Background Graphics
in Format Background pane,  290
on layout in PowerPoint,  290

Hide command, Excel worksheets,  611
Hide Page Title, OneNote,  662
HLOOKUP() function,  478
Home tab

Excel
Flash Fill command from,  431
Wrap Text button on,  444

PowerPoint
about,  256–257
Layout button from,  336
Order Objects tools from,  360
Paragraph dialog launcher from,  287

Word, Bullets and Numbering galleries from,  211–
212

Horizontal Bullet List Smart Art,  321
Hotmail,  73
HTML, saving Word documents as,  243
Hyperlink color, in PowerPoint,  279, 280
hyperlink format

for email and web addresses in Excel,  432
selecting cells in Excel in,  435

hyperlinks
creating to pages in OneNote custom,  702–704
tying OneNote notes together using,  700–702
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I
IFERROR() functions,  476
IF() function,  475
illustrations. See also graphics

formatting using Drawing Tools Format tool 
tab,  52

inserting in Office documents,  51
Illustrations group, in Excel

Screenshot button,  651
Shapes button,  645
Shapes button in,  643

images. See also graphics
adding frames to,  356
cropping in presentations,  356
displaying layout options for,  127
embed from online locations directly into Office 

documents,  44
inserting in Office documents,  51
inserting in OneNote pages,  676–677
inserting in presentations,  355–357
online pictures feature for,  44–45
placement in documents of,  127
removing backgrounds from,  361–363
resizing,  289
searching,  761–762

Import Text dialog box,  511
Increase Font Size button,  285
Increase List Level button,  306, 307
Indentation option,  197
indent markers, controlling on ruler,  287
Info page

about,  16–17
tools for recovering unsaved files,  23–25

ink
tools in OneNote,  108
vs. handwriting recognition,  108
working in OneNote with,  677–683
working in touch mode with,  107
working with,  108–112

Ink Comment button,  109
Ink Tools Pens tool tab,  108
Insert Chart dialog box,  56, 624
Insert Function dialog box,  462, 464–465, 473
inserting pictures, in presentations,  355–357
Insert Slicer button,  630

Insert Slicers dialog box,  630
Insert Space tool,  682
Insert tab

inserting illustrations using,  51
in Tables group,  217

Insert Table dialog box,  218
Insert Table feature, OneNote,  705–707
Insert Timeline button,  638
Insert Video page,  374–375
Inspect Document heading,  235
installation, Office, getting information about,  12–

13
integers, about,  461
international characters,  167–168
Internet, opening documents from Internet,  148
Inverse screen color, in Read Mode,  146
Invite People section

on Share Notebook page,  715
Share page,  88–89

iOS, sharing notes via SharePoint on,  723
iPad or iPhone, using OneNote on,  741–743
IPMT() functions,  479
italicizing selected text,  310

K
Keep lines together paragraph options,  205
Keep Source Formatting option

in Reuse Slides pane,  329
Paste Option to,  331

Keep with next page option,  205
keyboard access to menus and commands,  546
keyboard shortcuts

assigning to character or symbol custom,  168
bolding selected text,  310
centering text,  316
centering text in documents,  195
changing case of text,  203
clicking Previous button,  139
collapsing and expanding ribbon,  27
copying selected text or object,  311
creating new blank document,  85
decreasing font size,  285
demoting text in slides,  306
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displaying characters in uppercase,  201
displaying hidden text,  201
displaying small caps,  201
duplicating objects,  311
entering international characters,  167–168
entering SUM function,  458
entering symbols using,  167
formatting marks,  161
increasing font size,  285
italicizing selected text,  310
jumping to first cell in worksheet,  520
left aligning text,  316
manual page breaks,  203
moving around worksheets using Ctrl key,  440–

441
moving cursor,  155–156
moving cursor to beginning of sentence,  171
moving cursor to top of document,  195
navigating documents,  134
Nonbreaking space,  171
opening Font dialog box,  200
opening Link dialog box,  703
pasting selected text or object,  311, 331
promoting text in slides,  306
resetting character and paragraph formats,  196
saving files,  86–87
screen clipping capability,  758
Search box,  139
selecting Navigation pane check box,  139
selecting text,  157
starting presentations,  394
translating phrase,  151–152
underlining selected text,  310
undo the previous action,  270

KeyTips,  11

L
Label Options section, of Format Data Labels task 

pane,  634
Layout, as Read Mode option,  146
Layout button, in PowerPoint,  336
Layout Options button, in Word,  127
layouts

PowerPoint. See also slides
adding graphics to,  288–291
creating custom slides,  291–297

Word, using tables for page,  226
Layout tab, PowerPoint, viewing,  315
left aligning text,  316
LEFT() function,  476
LEN() function,  476
line breaks, manual line,  170
Line spacing, in Paragraph dialog box,  288
Line Spacing option,  198
Link dialog box,  703
Linked Contact Notes button,  697
linking

multimedia files to PowerPoint,  371
notes,  759–761

lists, formatting bulleted and numbered,  210–213
Live Layout, in Word,  127
Live Preview,  9
Lock Cell command,  491, 492
logical functions,  475–476
lookup functions,  478
Lowercase option,  202
LOWER() function,  476

M
Manage Styles dialog box,  190
manual line break,  170
manual page breaks,  203
manual tabs,  162

decimal tab as type of,  214, 220, 226
text alignment using,  214
using,  214–217

manual tab stops,  213
margin marker, in PowerPoint,  286
margins, toggling in Print Layout view,  120
Mark As Final option

in Excel,  573
in PowerPoint,  392
in Word,  238

math functions,  474–476
Max function,  462
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meetings, presentation through Office Presentation 
Service at,  62

menus, keyboard access to,  546
Merge Shapes tool,  353
messages, email

sending notes via,  728–729
sending to OneNote,  693–695

microphones, for recording audio,  756
Microsoft account

about,  73
signing into,  74–76
signing out of,  78
switching to another account,  76–77

Microsoft Excel
about,  421–422
about new features in,  417–418
about starting,  409–413
adding data to tables,  519–521
analyzing data from outside source,  508–511
cells in

changing case of text,  485–487
copying and pasting range of,  485
copying one or more cells to many,  447–448
deleting,  587–591
extending series with autofill,  429–431
format for email and web addresses,  432
formatting,  426–427, 550–551
inserting,  587–591
maximum number of characters in,  442
moving and adjusting,  442–444
pasting formulas as resulting values,  484–485
restricting entries,  487–492
using references,  467–470
validating entries,  470–472
working with text,  479–487

changing widths of spreadsheet columns,  423–426
charts

adding slicers to PivotCharts,  629–632
adding timelines to,  416, 637–639
creating and modifying,  623–629
manipulating objects in,  640–642

conditional formatting features,  504–507
creating custom sort list,  523–526
custom formatting codes,  554–555
data model,  512, 534

entering and organizing data,  422–423
filtering data with tables,  512–518
Filter menu commands,  518–519
Flash Fill command in,  413, 431–433
formatting cells,  550–551
formatting data,  426–429
formatting worksheets

applying number formatting,  538–541
applying percentage format to numbers,  558–

560
Clear Formats option,  546
creating custom themes,  546–549
custom number formats,  551–558
lining up positive and negative numbers in 

columns,  541
protection in,  570–572
setting view options,  574–578
with styles,  542–545
working with dates,  564–570
working with fractions,  560–564

formulas
about,  452
activating Edit mode,  469, 481, 493
dollar ($) sign in,  467–470, 493
entering,  452–456
equal (=) sign in,  452
static values vs. cell references,  457
using cell references,  467–470
using Formulas tab,  473–479
using names in,  470–472

functions
CONCATENATE(),  476, 479–482
date,  477–478
financial,  478–479
inserting,  464–467
logical,  475–476
math and trig,  474–476
PROPER(),  476, 486
reference,  478
text,  476–477
time,  477–478
TRIM(),  477, 483
using,  456–457
using AutoSum button,  457–460
using AVERAGE() function,  460–461
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using status bar for checking totals,  462
graphics in

creating and sharing,  642–648
using in other Office Applications,  648–653

inserting columns and rows,  583–587
inserting spreadsheets in OneNote,  763–764
jumping to first cell in worksheet,  520
manipulating elements in charts,  632–637
moving and copying columns and rows,  445–446
moving around worksheets,  439–441
online pictures feature in,  45
page layout options,  591–599
pages in

adjusting page breaks,  602–606
printing row and column labels,  599–602

panes,  591–599
performing What-If Analysis,  498–502
PivotTable Fields pane,  528
PivotTables. See also PivotTables

creating,  526–533
Recommended PivotTables feature,  415, 527
recovering unsaved files in,  24
Scenario Manager,  499–502
selecting and naming cell ranges,  434–437
sheet references in,  617–618
Simple to-do list workbook in,  49
sorting data,  521–523
table slicers,  415
templates

built-in,  495–498
storing formats in,  579–580

using column headers in defining names,  437–439
using Quick Analysis,  502–504
values in,  426, 429
workbooks

changing number of sheets setting in,  417
creating multisheet,  606–610
displaying separate windows,  414
managing multiple,  618–621
manipulating sheets in,  610–613
summarizing multisheet,  613–616

Zoom group,  603
Microsoft Office 365,  83
Microsoft Office cloud accounts. See also cloud 

services

about,  73
signing into,  74–76
signing out of,  78
switching to another account,  76–77
using cloud services with,  78–79

Microsoft Office Home & Student 2013 RT,  101
Microsoft OneNote. See also OneNote Mobile apps

about,  669
about getting started,  657–660
about navigating interface,  659–664
about new features in,  665–667
accessing notes in web browser,  738–740
changing search scope in,  709–710
connecting to Outlook

about,  693
annotating contacts,  697–698
appointments,  695–697
sending email messages to OneNote,  693–695
tasks,  698–700

correcting grammar errors in touch mode,  105
creating and organizing

pages,  674–677
sections,  671–673

creating custom hyperlinks to other pages,  702–
704

creating notebook,  670–671
custom styles in,  693
exporting to other formats,  730–732
file server

sharing notes on,  718–723
stop sharing on,  721–723

finding tags,  751–754
inking tools in,  108
inserting spreadsheets in,  763–764
linking notes,  759–761
printing PDFs to,  762
recording audio,  755–756
Require User To Sign In Before Accessing 

Document check box,  716
searching images,  761–762
searching notes,  707–710
section groups in,  673
sharing notes

during meetings,  727–728
on file server,  718–723
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via email messages,  728–729
via SharePoint,  723–726

SkyDrive
accessing notes in,  738
creating notebooks on,  713–716
moving notebook to,  716–718
stop sharing in,  718
syncing notebooks using,  743
syncing notes using,  735–738

tables
creating and organizing,  704–705
Insert Table feature,  705–707
maximum size of,  706

tags
creating and customizing,  690–692
using,  688–689

templates,  765–767
tying notes together using hyperlinks,  700–702
using Napkin Math feature,  765
using on phone or tablet,  740–741
using Quick Notes,  756–757
using screen clippings,  758–759
using styles to format notes,  692–693
working with ink and shapes,  677–683

Microsoft Outlook, connecting to OneNote
about,  693
annotating contacts,  697–698
appointments,  695–697
sending email messages to OneNote,  693–695
tasks,  698–700

Microsoft PowerPoint
about,  253–256
about new features in,  259–264
adding and formatting shapes,  336–341
alignment tools in,  289, 340. See also Smart 

Guides, in PowerPoint
applying enhanced fills and effects,  342–349
converting inked drawing to shape in,  110–111
creating custom shapes,  349–354
customizing,  271–276
inserting and formatting charts in,  316–320
online pictures feature in,  45
placeholders in

formatting on slide master,  283–288
inserting pictures in,  355

selecting,  284
troubleshooting selecting,  366
turning off title and footer,  293

presentations. See also presentations
changing presentation to widescreen 

format,  297–300
creating PDFs of,  389
delivering,  394–401
editing video,  371–373
finalizing,  391–394
formatting pictures in,  354–360
inserting comments in,  384–385
inserting online video into,  65, 374–375
practicing,  401–406
removing backgrounds from pictures,  361
saving as video,  375–377
using theme variant,  268

recovering unsaved files in,  24
Shapes gallery in,  309
slide master,  283–291
slides

adding and formatting tables in,  313–316
adding and renaming sections,  380–383
adding manual text boxes,  308–313
adding text to placeholders,  304–308
applying transitions to,  371–373
bullet points in,  306, 321–325
choosing layout for,  304, 313–316
copying graphics to,  341–342
creating and formatting charts,  313–316
creating and formatting SmartArt 

diagrams,  320–325
creating custom layout,  291–297
default size of,  259
editing video,  371–373
Fit Slide to Current Window button,  289
inserting comments in,  384–385
notating using inking tools,  109
placeholders,  304
playing sound across,  373
printing,  386–390
reusing and keeping source formatting,  326–

333
selecting animations on,  367
selecting groups of,  331
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transitions in,  261
Smart Guides in,  289, 311, 352
starting,  253
starting presentation using theme variant,  268
templates,  297
themes. See also themes

applying background styles to 
presentations,  281–283

applying to existing presentations,  269–271
creating presentations using theme 

variants,  268
tools in,  256–258
word completion, in touch mode,  105

Microsoft SharePoint, sharing notes via,  723–726
Microsoft SkyDrive

about,  84
accessing notes in,  738
changing permissions,  90
connecting to,  79–81
creating notebooks on,  713–716
moving notebook to,  716–718
opening files from,  42
opening files from cloud,  90–91
saving files on,  42, 85–87
sharing files from,  88–90
signing into,  84
stop sharing in,  718
syncing files for offline use with,  92–96
syncing notebooks on,  743
syncing notes using,  735–738

Microsoft Surface
automatic phrase translation on,  151
viewing documents in,  239

Microsoft Surface, using Read Mode on,  146
Microsoft Windows 7

modifying screen resolution,  14–15
starting Office application in,  4–5

Microsoft Windows 8
modifying screen resolution,  14–15
starting Office application in,  4–5
tablet edition of,  101
Window control buttons,  7–8
Windows Explorer vs. File explorer,  92

Microsoft Windows RT
about,  101

on Windows 8 tablet,  748
Microsoft Word

about new features in,  123–129
alignment guides in,  127
composing documents

inserting special characters,  169–171
inserting symbols,  165–166, 168
using AutoCorrect,  167–168, 172–175
using building blocks,  176–180
using formatting marks in,  161–164
using international characters,  167–168

correcting proofing errors,  230–232
creating across applications coordinating 

documents,  128
documents created in earlier versions of,  129
editing documents

moving cursor by keyboard shortcuts,  155–156
selecting text,  156–160

file extension for,  116
formatting documents

about,  183–188
changing case of text,  200–201
exploring character formatting,  200–201
exploring paragraph formatting,  196–198
managing pagination through,  203–207
setting default documents,  188–190
setting section formatting,  190–192
using styles for,  192–196

heading styles in documents,  141–144
inspecting documents before publishing,  233–237
Layout Options button in,  127
Live Layout in,  127
making documents final,  238
modifying document view,  119–120
online pictures feature in,  45
opening files from cloud,  90–91
PDFs

creating,  239–244
editing,  239, 243–244
Reflow feature,  124

presentations, inserting online video into,  65–69
presenting information in

inserting tables,  217–223, 223–227
using bulleted lists,  209, 210–213
using numbered lists,  209, 210–213
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using tabbed lists,  210, 213–217
using tables,  210

printing documents,  245–249
Read Mode

exploring research tools in,  148–152
viewing documents in,  144–148

recovering unsaved files in,  24
resume reading feature in,  124
ribbon,  117–119
saving files on cloud,  85–87
scrolling documents,  134–135
selecting document content,  157
setting default formatting for documents,  128
splitting screen in,  122–123
starting,  115–116
tables,  125
threaded comments in,  126
turning on ruler display,  122
using Navigation pane,  135–141
word completion, in touch mode,  105
Zoom group in,  120–121

Min function,  462
Mini Toolbar,  10
mm (Minutes), Excel date formatting code,  570
mobile phones, using OneNote on,  740
More Options button,  319
mouse

scrolling documents using,  134–135
selecting text using,  157, 159

Move Notebook option, on Share Notebook 
page,  717

mp4 formatted video, saving presentation as,  375–
377

multimedia files, linking to PowerPoint,  371

N
names

using in Excel column headers in defining,  437–439
using in formulas,  470–472

naming, cell ranges in Excel,  434–437
Napkin Math feature,  765
Navigation Grid, in PowerPoint,  397–398
Navigation pane

about,  136
Headings section,  137
Word

as mini table of contents,  137
options,  136–138
searching and navigating documents,  135–141
selecting heading with,  159

Navigation Pane option, in Read Mode,  145
Nested IF() function,  475
NETWORKDAYS() function,  478
New Docked Window, OneNote,  663
New Name dialog box, in Excel,  436, 437
New page,  17–19
New Slide button,  305, 313–316
Next and Previous buttons, using in 

documents,  137
Next Page section breaks,  191
Nonbreaking space,  171
Normal view

in OneNote,  659–660
in Word,  120

Notebook pane, OneNote,  659
Notebook Recycle Bin button,  684–685
notebooks, OneNote

about,  669
creating,  670–671

in OneNote Mobile apps,  743
in SkyDrive,  713–716

creating and organizing
pages,  674–677
sections,  671–673

moving to SkyDrive,  716–718
working with ink and shapes,  677–683

notes, OneNote
accessing in SkyDrive,  738
adding and organizing OneNote,  675–676
creating in OneNote Mobile apps,  743
linking,  759–761
sharing

during meetings,  727–728
on file server,  718–723
via email messages,  728–729
via SharePoint,  723–726

stop sharing on file server in,  721–723
syncing notes in SkyDrive,  735–738
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notes pane, in PowerPoint,  256
notes, printing presentation,  386–390
NOW() function,  477
NPER() functions,  479
numbered lists

about,  209
formatting,  210–213

Number Filters command,  519
Number Format drop-down menu, in Excel,  426–

427
number formatting, Excel

applying number formatting,  538–541
applying percentage format to,  558–560
lining up positive and negative numbers in 

columns,  541
working with custom number formats,  551–558
working with fractions,  560–564

number next to PowerPoint animation,  369

O
objects, manipulating in Excel,  640–642
Odd Page or Even Page section breaks,  191
Office 365

about,  83
Office applications

elements in application window,  6–13
Account commands,  12–13
dialog box launcher,  8
galleries,  8–9
KeyTips,  11
Live Preview,  9
Mini Toolbar,  10
Quick Access Toolbar,  8
ribbon,  6
Screen Tips,  10–11
status bar,  8
title bar,  7
tool tabs,  8

shared features in,  42
starting,  4–5
streaming,  83
supporting touch,  47, 101–112
using graphics between,  648–653

Office cloud accounts. See also cloud services
about,  12, 73
signing into,  74–76
signing out of,  78
switching to another account,  76–77
using cloud services with,  78–79

Office documents. See also files
co-authoring,  97–98
creating new,  60
inserting

apps in,  47
charts in,  54–57
illustrations in,  51
pictures in,  51
shapes into,  52
SmartArt graphic in,  52

online pictures embed directly into,  44
online presentations,  44, 62–65
online sharing of,  44
online video in,  45–46, 65–69
sharing with social networks,  46

Office Home & Student 2013 RT,  101–103
Office installation, getting information about,  12–

13
Office on Demand,  83
Office Presentation Service

PowerPoint presentation through,  62–65
sharing Office documents through,  44

Office themes
applying,  47–50
changing,  12

OneNote. See also OneNote Mobile apps
about,  669
about getting started,  657–660
about navigating interface,  659–664
about new features in,  665–667
accessing notes in web browser,  738–740
changing search scope in,  709–710
connecting to Outlook

about,  693
annotating contacts,  697–698
appointments,  695–697
sending email messages to OneNote,  693–695
tasks,  698–700

correcting grammar errors in touch mode,  105
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creating and organizing
pages,  674–677
sections,  671–673

creating custom hyperlinks to other pages,  702–
704

creating notebook,  670–671
custom styles in,  693
exporting to other formats,  730–732
file server

sharing notes on,  718–723
stop sharing on,  721–723

finding tags,  751–754
inking tools in,  108
inserting spreadsheets in,  763–764
linking notes,  759–761
printing PDFs to,  762
recording audio,  755–756
Require User To Sign In Before Accessing 

Document check box,  716
searching images,  761–762
searching notes,  707–710
section groups in,  673
sharing notes

during meetings,  727–728
on file server,  718–723
via email messages,  728–729
via SharePoint,  723–726

SkyDrive
accessing notes in,  738
creating notebooks on,  713–716
moving notebook to,  716–718
stop sharing in,  718
syncing notebooks using,  743
syncing notes using,  735–738

tables
creating and organizing,  704–705
Insert Table feature,  705–707
maximum size of,  706

tags
creating and customizing,  690–692
using,  688–689

templates,  765–767
tying notes together using hyperlinks,  700–702
using Napkin Math feature,  765
using on phone or tablet,  740–741

using Quick Notes,  756–757
using screen clippings,  758–759
using styles to format notes,  692–693
working with ink and shapes,  677–683

OneNote Mobile apps
about,  740
creating notebooks in,  743
creating notes in,  743
using on Android,  743–745
using on iPad or iPhone,  741–743
using on Windows phone,  746–747
using on Windows Phone 8 tablet,  747

OneNote Web App,  738–740
online

pictures feature,  44–45
presentations,  44, 62–65
templates,  42, 58–62
video

inserting into presentations,  65–69, 374–375
playing back in Office documents,  45–46
saving in video presentation,  377

on-screen keyboard,  105
Open Document Format ODF 1.2,  418
OpenDocument, saving Word documents as,  243
Open page,  20, 91
Option commands,  13
Options dialog box, in Word,  242
Order Objects tools,  360
Orientation button,  604
Or Select a Category list, in Insert Function dialog 

box,  464
Outline level document option,  197
Outline view

in Word,  120
Outlook.com, signing up for,  73
Outlook, connecting to OneNote

about,  693
annotating contacts,  697–698
appointments,  695–697
sending email messages to OneNote,  693–695
tasks,  698–700

Outlook Tasks button,  698
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P
Page break before page option,  205
Page Break Preview mode,  604
page breaks, adjusting Excel,  602–606
Page Color, as Read Mode option,  146
page layout options, in Excel,  591–599
pages

Excel
adjusting page breaks,  602–606
printing row and column labels,  599–602

OneNote
creating and organizing,  674–677
recovering deleted,  684–685

Page Setup dialog box,  601
pages feature, in Navigation pane,  137
Page tabs, OneNote,  659
Page Templates button,  765
Page Width command, in Word,  120
pagination, managing through formatting,  203–

207
panes, in Excel,  591–599
Paper Size, OneNote,  662
Paragraph dialog box

After spacing,  288
Before spacing,  288
Line spacing in,  288
Paragraph pagination options in,  204

Paragraph dialog launcher, from Home tab,  287
paragraph formats

exploring,  196–198
pagination options for,  203–207
resetting,  196
using styles for,  192–196

Paragraph group, Bullets and Numbering galleries 
in,  211–212

Paragraph group dialog box,  197
Paragraph pagination options,  204
Paste Options

palette,  485
to keep source formatting,  331

Paste Special, Values button in,  486
Paste Values group, Values button in,  485
pasting

formulas as resulting values,  484–485
range of cells,  485

pasting selected text or object,  311, 331
PDF (Portable Document Format)

creating from presentations,  389
editing in Word,  124
printing to OneNote,  762
saving files as,  22

PDF Reflow feature, in Word,  124
Pen and Laser Pointer Tools icon, in 

PowerPoint,  404, 406
pens, OneNote,  679
permissions

removing on file server user,  721–723
removing on SkyDrive user,  718

Permissions drop-down box,  90
personal cloud services, connecting to,  80–81
Personal (Web),  743
phones, using OneNote on,  740
Pictures button,  51
pictures (photos). See also graphics

adding frames to,  356
cropping in presentations,  356
displaying layout options for,  127
embed from online locations directly into Office 

documents,  44
inserting in Office documents,  51
inserting in OneNote pages,  676–677
inserting in presentations,  355–357
online pictures feature for,  44–45
placement in documents of,  127
removing backgrounds from,  361–363
resizing,  289
searching,  761–762

Picture Tools Format tab,  52
accessing PowerPoint picture formatting tools 

from,  358
Crop button on,  356, 652
in slide master,  289
Remove Background button on,  361–362
Reset Picture button on,  359
Transparent Wand tool from,  362

pinch gestures, in touch mode,  106
pinning files,  20
PivotChart Fields task pane,  625
PivotCharts

adding slicer to,  418, 629–632
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creating and modifying,  623–629
PivotChart Tools Analyze tab,  627, 630, 638
PivotChart Tools Design tab,  627, 633
PivotChart Tools Format tab,  642
PivotChart Tools tabs,  625, 638
pivot icons,  624–625
PivotTable Fields pane,  528
PivotTables

creating,  526–533
Field List,  418
in determining to use,  624–625
Recommended PivotTables feature,  415

pixels, in screen resolution,  15
placeholders

about,  256
formatting on slide master,  283–288
inserting pictures in,  355
selecting,  284
slide

about,  304
adding text to,  304–308

troubleshooting selecting,  366
turning off title and footer,  293

Play in Background button,  373
pm/am, Excel date formatting code,  570
PMT() functions,  479
Pointer Options, in Slide Show view,  398
Popup Toolbar, activating during PowerPoint 

presentations,  397
Post to Social Networks option,  46
pound sign (#), as Excel formatting code,  554
PowerPoint

about,  253–256
about new features in,  259–264
adding and formatting shapes,  336–341
alignment tools in,  289, 340. See also Smart 

Guides, in PowerPoint
applying enhanced fills and effects,  342–349
converting inked drawing to shape in,  110–112
creating custom shapes,  349–354
customizing files,  271–276
inserting and formatting charts in,  316–320
online pictures feature in,  45
placeholders in

formatting on slide master,  283–288

inserting pictures in,  355
selecting,  284
troubleshooting selecting,  366
turning off title and footer,  293

presentations. See also presentations
changing presentation to widescreen 

format,  297–300
creating PDFs of,  389
delivering,  394–401
editing video,  371–373
finalizing,  391–394
formatting pictures in,  354–360
inserting comments in,  384–385
inserting online video into,  65, 374–375
practicing,  401–406
removing backgrounds from pictures,  361–363
saving as video,  375–377
using theme variant,  268

recovering unsaved files in,  24
Shapes gallery in,  309
slide master,  283–291
slides

adding and formatting tables in,  313–316
adding and renaming sections,  380–383
adding manual text boxes,  308
adding text to placeholders,  304–308
applying transitions to,  371–373
bullet points in,  306, 321–325
choosing layout for,  304, 313–316
copying graphics,  341–342
creating and formatting charts,  313–316
creating and formatting SmartArt 

diagrams,  320–325
creating custom layout,  291–297
default size of,  259
editing video,  371–373
Fit Slide to Current Window button,  289
inserting comments in,  384–385
notating using inking tools,  109
placeholders,  304
playing sound across,  373
printing,  386–390
reusing and keeping source formatting,  326–

333
selecting animations on,  367
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selecting groups of,  331
selecting in touch mode,  107
transitions in,  261

Slide Sorter view
selecting slides in touch mode,  107

Smart Guides in,  289, 311, 352
starting,  253
templates,  297
themes. See also themes

applying background styles to 
presentations,  281–283

applying to existing presentations,  269–271
creating presentations using theme 

variants,  268
tools in,  256–258
word completion, in touch mode,  105

PowerView,  418
presentations

3-D charts in,  629
adding and formatting shapes,  336–341
adding graphics to,  288–291
applying background styles to,  281–283
applying enhanced fills and effects,  342–349
applying text formatting in,  283, 347
changing to widescreen format,  297–300
creating PDFs of,  389
customizing,  271–276
delivering,  394–401
editing saved slide show,  401
editing video,  371–373
finalizing,  391–394
formatting pictures in,  354–360
inserting comments in slides or objects,  384–385
inserting online video into,  65–69, 374–375
playing sound across slides,  373
practicing,  401–406
printing slides and notes,  386–390
removing backgrounds from pictures,  361–363
saving as video,  375–377
sharing Office documents in online,  44
starting using theme variant,  268
theme colors vs. direct colors,  341–342
themes,  269–271
through Office Presentation Service,  62–65
viewing on two monitors,  396

Presenter view, PowerPoint,  260, 401–406
presenting information in Word

using bulleted lists,  209, 210–213
using numbered lists,  209, 210–213
using tabbed lists,  210, 213–217
using tables,  210, 217–223, 223–227

Previous and Next buttons, using in 
documents,  137

Print All Slides option,  387
Print button,  22
Print command

in Excel,  412
Print Heading and Content option,  249
printing

documents,  245–249
hidden text,  201
presentation slides and notes,  386–390

Print Layout view, in Word,  119–120
Print One-Sided option,  246
Print page,  21
Print Titles command,  599, 602
PRODUCT() function,  475
Product Information, getting information about 

Office installation,  13
promoting text in slides,  306
PROPER() function,  476, 486
Protect Current Sheet option,  574
Protect Document button,  238
Protect Sheet dialog box.,  490
Protect Sheet option,  491
Protect Workbook button,  573
Protect Workbook Structure option,  574
Publish button,  242

Q
Question tag, OneNote,  754
Quick Access Toolbar

about,  8
adding commands to

in Excel,  412
in Office,  28–29
in OneNote,  659
in PowerPoint,  255
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in Word,  118
backing up to share with others,  35
customizing,  123
displaying through KeyTips,  11
green arrows on Save button,  91
moving below ribbon,  27
removing commands from,  28–29, 118
vs. ribbon commands,  32
Word,  118

Quick Analysis tools, using,  502–504
Quick Notes,  756–757
Quick Parts option,  178
quotation marks (“ ”)

as Excel formatting code,  555
using in searches,  710

R
RANDBETWEEN() functions,  475
range of cells, copying and pasting,  485
Read Mode

as document view,  119
closing,  145
exploring research tools in,  148–152
viewing documents in,  144–148
vs. Full Screen mode,  119

recent files, viewing,  20
Recent Folders list

pinning and unpinning folders to,  20
Recents button, OneNote Mobile apps,  743
Recommended Chart feature,  415, 623
Recommended PivotTables feature,  415
Recommended PivotTables feature, Excel,  527
recording audio, OneNote,  755–756
recovering

deleted sections or pages in OneNote,  684–685
unsaved files,  23–25

Rectangle tool,  336
reference functions,  478
Remove Background tool,  361–362
Remove From Quick Access Toolbar,  412
Remove Gradient Stop button,  345
Remove Section option,  383

Remove Section & Slides option, in Slide Sorter 
view,  383

Remove Split command,  123
removing. See deleting
Rename Master menu choice, from Slide Master 

view,  291
Rename Section dialog box,  381
reordering animations,  370
Require User To Sign In Before Accessing Document 

check box, in OneNote,  716
Research pane,  152
research tools, exploring in Read Mode,  148–152
resizing

objects in touch mode,  106, 110–112
pictures,  289
presentation, troubleshooting,  300
split screens in Word,  122–123

Results option, in Navigation pane,  138
resume reading feature

in PowerPoint,  261
in Word,  124

Retrospect theme,  268, 270
Reuse Slides gallery,  326–333
Review tab, Define and Translate commands 

on,  152
revising documents, using simple markup,  126
ribbon

about,  6
adjusting display of,  14–15
backing up to share with others,  35
collapsing and expanding,  27
customizing,  32–35
Excel,  411
moving Quick Access Toolbar below,  27
OneNote,  658
PowerPoint,  254–255
setting to auto-hide state,  27
vs. Quick Access Toolbar commands,  32
Word,  117–119

Ribbon Display Options button,  575
in Excel,  413
in Office,  7–8
in PowerPoint,  256
in Word,  118

right-clicking objects
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to format shapes,  345
troubleshooting,  338

right-clicking pictures, to access PowerPoint picture 
formatting tools,  358

RIGHT() function,  477
roaming profiles,  72
rotating, text boxes,  312
ROUNDDOWN() functions,  475
ROUND() functions,  475
ROUNDUP() functions,  475
ROW([reference]) functions,  478
rows

deleting OneNote table,  707
deleting Word table,  222–223
spreadsheets in Excel

changing widths of,  426
inserting in,  583–587
moving and copying,  445–446
printing row labels in,  599–602

ROWS(array) functions,  478
Rule Line Color option, OneNote,  662
Rule Lines button,  661–662
ruler display

controlling indent markers on,  287
setting indents in,  198–199
viewing measurements on,  216

ruler display, turning on,  122
Running Total button,  504

S
sans serif and serif fonts,  188
Save As command, in Excel,  412
Save button, green arrows on Quick Access 

Toolbar,  91
Save Selection to Quick Part gallery,  178
Scenario Manager,  499
Scenario Manager dialog box.,  501
Scope options, in New Name dialog box in 

Excel,  437
screen clippings,  758–759
Screen Clipping tool,  676
screen colors, in Read Mode,  15, 146
screen resolution, modifying,  14–15

Screenshot button,  355, 651
Screen Tips,  10–11
scroll bars,  134–135
Scroll Here command,  135
scrolling

documents,  134–135
in touch mode,  105–107

Search document
as Navigation pane option,  138
screen colors in Read Mode,  136

searching
for online templates,  58–62
notes in OneNote,  707–710
notes in OneNote Mobile apps,  743
using quotation marks in,  710

Search with Bing option, in Research pane,  152
section groups, OneNote,  673
sections

adding and renaming,  380–383
printing documents with,  248

sections, OneNote
creating and organizing,  671–673
recovering deleted,  684–685

Section tabs, OneNote,  659
security

protecting worksheets,  570–572
Require User To Sign In Before Accessing 

Document check box in OneNote,  716
restricting entries in worksheets,  487–492

See All Slides button,  397
Select All button, in Excel,  443
selecting

cell ranges in Excel,  434–437
content in touch mode,  106–107
phrase for translation,  151–152
text in documents,  156–160
Word tables,  225

selection handle, in Excel, extending series 
using,  429

selection mode, selecting text in,  158
Send Backward button,  645
Send to OneNote Tool,  663–664
Sentence case option,  202
Sepia screen color, in Read Mode,  146
serif and sans serif fonts,  188
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Set As Default button, in Find Options dialog 
box,  140

Set Transparent Color tool,  362
shadow options, accessing,  345, 646
Shape Effects button,  642
Shape Fill button,  343
Shape Options Effects button,  345
Shape Options Fill and Line icon,  344
shapes

adding and formatting in PowerPoint,  336–341
adding animation to presentation,  366–370
applying 3-D effects to,  346–349
creating custom,  349–354
creating perfect,  336
displaying layout options for,  127
inserting in Office documents,  52
placement in documents of,  127
removing border from,  345
selecting,  337
using adjustment handles,  349–351
working in OneNote with,  677–683

Shapes button,  643, 645
Shapes gallery, in PowerPoint,  309, 336
Shapes icon,  336
Shape Styles group

Drawing Tools Format tool tab in,  52
Shape Effects button in,  642

Shape Styles palette, from Drawing Tools Format 
tab,  337, 644

Share command, in Excel,  412
shared features in Office 2013, identifying new,  42
Share Notebook page

Invite People section on,  715
Move Notebook option on,  717

Share Notes With This Meeting Occurrence, 
OneNote,  696

Share page
about,  22
Invite People section on,  88–89

SharePoint Online
accessing locations hosted by school or 

company,  92
changing permissions,  90
connecting to,  79–81
opening files from,  42

opening files from cloud,  90–91
saving files from,  42
saving files on,  85–87
sharing files from,  88–90

SharePoint, sharing notes via,  723–726
sharing files

changing permissions,  90
form cloud,  88–90

sheet references, Excel,  617–618
Show Comments, as Read Mode option,  145
Show/Hide ¶ button,  163, 201, 215
Show Tabs and Commands option,  576
Sign in to Office screen,  74
simple markup, for tracking changes in 

documents,  126
Simple to-do list workbook,  49
Size group, Crop button from,  652
SkyDrive

about,  84
accessing notes in,  738
changing permissions,  90
connecting to,  79–81
creating notebooks on,  713–716
moving notebook to,  716–718
opening files from,  42
opening files from cloud,  90–91
saving files on,  42, 85–87
sharing files from,  88–90
signing into,  84
stop sharing in,  718
syncing files for offline use with,  92–96
syncing notebooks on,  743
syncing notes using,  735–738

Slicer buttons,  637
slicers feature

about,  418
adding to PivotCharts,  629–632

Slicer Styles palette,  631
Slicer Tools Options tab,  631
Slide Library feature, companies using,  328
slide master

adding graphics to,  288–291
formatting placeholders on,  283–288

Slide Master view,  272, 284, 291
slides
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adding and formatting tables in,  313–316
adding and renaming sections,  380–383
adding manual text boxes,  308–313
applying transitions to,  371–373
bullet points in,  306, 308
choosing layout for,  304, 313
copying graphics,  290, 341–342
creating and formatting charts,  313–316
creating and formatting SmartArt diagrams,  320–

325
creating custom layouts for,  291–297
default size of,  259
Fit Slide to Current Window button,  289
inserting comments in,  384–385
notating using inking tools,  109
placeholders,  304
playing sound across,  373
printing,  386–390
reusing and keeping source formatting,  326–333
selecting animations on,  367
selecting groups of,  331
selecting in touch mode,  107
transitions in,  261

Slide Show
pop-up toolbar,  261
view,  260
zoom,  261

Slide Show view
comments and,  384–385
opening presentation in,  401
Pointer Options in,  398
seeing full-screen,  396
view complete list of shortcuts available during 

presentations,  396
ways to navigate in,  396

Slide Size menu choice,  299
Slide Sorter view,  107

accessing,  381
Remove Section & Slides option in,  383

slides pane, in PowerPoint,  256
SLN() functions,  479
Small Caps font format option,  201
SmartArt button,  52
SmartArt diagrams

creating and formatting,  320–325

troubleshooting size of text in SmartArt 
diagrams,  325

SmartArt graphics
changing bulleted list text into,  321–325
inserting in Office documents,  52

SmartArt Styles gallery,  324
SmartArt Tools Design tool tab,  54, 323
Smart Guides, in PowerPoint,  289, 311, 352
smart phones, using OneNote on,  740
social networks, sharing Office documents with,  46
Sort commands,  518
Sort dialog box, Excel,  521, 584
sorting data,  521–523
sort list, creating custom,  523–526
sound

linking files to PowerPoint,  371
playing across slides,  373

Space Before and Space After option in document 
formatting,  198

special characters inserting,  169–171
spell checking,  230–231
Spelling And Grammar Check icon,  230–231
split control

of commands on ribbon,  6–7
Text Highlight Color,  187

splitting screen, in Word,  122–123
spreadsheets

cells in,  424, 425
changing case of text,  485–487
copying and pasting range of,  485
deleting,  587
formatting,  550–551
inserting,  587–591
pasting formulas as resulting values,  484–485
removing extra spaces,  482–484
restricting entries,  487–492
using references,  467–470
validating entries,  470–472
working with text,  479–487

changing widths of columns,  423–426
changing widths of rows,  426
charts in,  623–629. See also charts
creating and sharing graphics,  642–643
creating PivotTables,  526–533
formatting
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applying number formatting,  538–541
applying percentage format to numbers,  558–

560
Clear Formats option,  546
creating custom themes,  546–549
custom number formats,  551–558
lining up positive and negative numbers in 

columns,  541
setting view options,  574–578
with styles,  542–545
working with dates,  564–570
working with fractions,  560–564

inserting columns,  583–587
inserting in OneNote,  763–764
inserting rows,  583–587
jumping to first cell in,  520
moving and copying columns and rows on,  445–

446
moving around,  439–441
page layout options,  591–599
pages in

adjusting page breaks,  602–606
printing row and column labels,  599–602

panes,  591–599
performing What-If Analysis,  498–502
protecting,  570–572
selecting entire,  443
sheet references in,  617–618
storing formats in templates,  579–580
using built-in templates,  495–498

square bullet character, formatting mark for 
paragraph pagination options,  205

s (Seconds), Excel date formatting code,  570
Start Automatically setting, in Video Tools Playback 

tab,  371
Start Inking button,  108
Start On Click setting, in Video Tools Playback 

tab,  371
Start screen, application

about,  4–5
templates in,  58
Word,  115–116

static values vs. cell references in formulas,  457
status bar

customizing,  30–31

in Excel,  413, 462
in Office,  8
in PowerPoint,  256
in Word,  119

Stop Automatically Expanding Tables 
command,  520

Stop option, on AutoCorrect feature,  172–175
streaming, Office applications,  83
Strict Open XML file format,  418
Strikethrough font format option,  201
Stroke Eraser, OneNote,  681
Style menu, Chart Styles button in,  626–627
styles

formatting in Excel with,  542–545
formatting in Word using,  192–196
in OneNote,  676, 692–693

Style Sets gallery, in Word,  128
Styles galleries

Excel,  542
Word,  184

subpages, creating OneNote,  675
SUM function,  457–460
SUMIF() function,  474
SUMPRODUCT() functions,  475
Surface

automatic phrase translation on,  151
viewing documents in,  239

Surface, using Read Mode on,  146
switching to another Office account,  76–77
Symbol button, OneNote,  691
Symbol dialog box,  165–166
symbols, inserting in documents,  165–166, 168
Synchronous Scrolling button,  578
syncing files, for offline use with SkyDrive,  92–96

T
tabbed lists

about,  210
creating,  213–217

Table gallery, in Word,  217
table of contents, Navigation pane as mini,  137
tables

Excel
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adding data to tables,  519–521
filtering data with,  512–518

OneNote
creating and organizing,  704–705
maximum size of,  706
using Insert Table feature,  705–707

PowerPoint, adding and formatting in,  313–316
Word,  125

about,  210
borderless,  226
enhancing,  223–227
inserting,  217–223
selecting,  223–227

Tables group, Insert tab in,  217
table slicers, in Excel,  415
Table Style Options group, on Table Tools Design 

tool tab,  223
Table Styles gallery, in PowerPoint,  315
Table Styles gallery, on Table Tools Design tool 

tab,  223
tablet computers

sharing notes via SharePoint on,  723
touch mode

about,  47, 101–103
disabling,  103
handwriting recognition vs. ink,  107
selecting content in,  106–107
using,  103–106
working with ink in,  107

using Read Mode on,  146
Windows 8 for,  101

Table Tools Design tool tab,  223–224, 315, 513
Table Tools Layout tool tab,  222
tabs

decimal,  214, 220, 226
manual tab stops,  213
text alignment using,  214
using manual,  214–217

tags, OneNote
creating and customizing,  690–692
using,  688

Tags Summary pane, OneNote,  752, 753
Take Notes On Your Own, OneNote,  696
tasks, connecting Outlook to OneNote,  698–700
Tell Me More is display, on Screen Tips,  11

templates
accessing online,  42
Excel

built-in,  495–498
storing formats in,  579–580

OneNote,  765
saving PowerPoint,  297
searching for online,  58–62
Simple to-do list workbook,  49

text
adding animation to presentation,  366–370
adding text to slides,  304
aligning using tabs,  214
applying formatting in presentations to,  283, 347
disappearing when copying slides,  283
formatting. See also keyboard shortcuts

about,  183–188
changing case of text,  200–201
exploring character,  200–201
exploring paragraph,  196–198
setting section formatting,  190–192
using styles for,  192–196

functions,  476–477
making circular,  348
selecting in documents,  156–160
using Eyedropper Text Fill tool,  340
working in Excel with

changing case of text,  485–487
combining into one string,  479–482
copying and pasting range of cells,  485
pasting formulas as resulting values,  484–485
removing extra spaces,  482–484

text boxes
adding to slides manual,  308
rotating,  312

Text Effects button, in WordArt Styles group,  646
Text Filters command,  519
Text Highlight Color button,  187
Text Import Wizard,  509–510
text wrapping, turning off,  444
Theme Colors gallery

in PowerPoint,  278, 280
theme effects,  47
Theme Effects sets, in PowerPoint,  280–281
Theme Font gallery, in PowerPoint,  272, 277
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themes
applying,  47–50
changing,  12
creating in Excel custom,  546–549

Themes button,  49, 549
Themes gallery,  49, 270, 549
themes, presentation

applying background styles to,  281–283
applying to existing presentations,  269–271
creating presentations using variants,  268
customizing,  272–273, 273–275, 277–281
theme colors vs. direct colors,  341–342

theme variant, starting presentation using,  268
Thesaurus, as research tool,  152
threaded comments, in Word,  126
tilde (~), entering from keyboard,  168
time() function,  477–478
Timeline bar,  639
Timeline button,  638
timelines, adding to charts,  416, 637–639
Timeline Tools Options tab,  639, 641
title bar

in Excel,  413
in Office,  7
in OneNote,  659
in PowerPoint,  255
in Word,  118, 129

Title Slide,  304
TODAY() function,  477
Toggle case option,  202
tool tabs,  8
top page margins, toggling in Print Layout 

view,  120
Total Row formatting,  223
total screen count, in Read Mode,  146
touch-enabled devices, gesture to zoom on 

slide,  400
touch mode

about,  47, 101–103
disabling,  103
handwriting recognition vs. ink,  107
selecting content in,  106–107
using,  103–106
working with ink in,  107

touch mode, Office applications,  47

touchpad, scrolling documents on,  134–135
tracking changes in documents, using simple 

markup,  126
transitions, applying to animations in slides,  371–

373
Translate feature, as research tool,  151–152
translating service,  151–152
Transparent Wand tool,  362
trig functions,  474–476
TRIM() function,  477, 483
Trim Video dialog box,  372
troubleshooting

bullet points,  306
chart error messages,  318
getting embed code from YouTube,  375
Presenter view,  402
resizing presentation,  300
right-clicking objects,  338
selecting placeholders,  366
selecting sections,  381
size of Shapes gallery in PowerPoint,  309
size of text in SmartArt diagrams,  325
Slide Show view,  396
Start On Click setting in Video Tools Playback 

tab,  371
text disappearing when copying slides,  283

Twitter, connecting to personal cloud service 
in,  80–81

Type group
Change Chart Type button in,  627–628, 633

U
underscore (_), as Excel formatting code,  554
Undo button,  156
unpinning files,  20
Unprotect Sheet option,  491
Up and Down arrows, using in Animation 

pane,  370
Uppercase option,  202
UPPER() function,  477
USB flash drive, sharing OneNote notes using,  749
user interface, customizing,  25–31
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V
Values button

in Paste Special,  486
in Paste Values group,  485

values, in Excel,  426, 429
Variants gallery, in PowerPoint,  270, 277, 280
variants, in PowerPoint

about,  268
applying to existing presentations,  268
creating presentations using theme,  268

versions file, opening previous,  24
video. See also online: video

canceling conversion of presentation into,  377
editing,  371–373
inserting and playing in presentations online,  374–

375
linking files to PowerPoint,  371
placement in documents of,  127
playing back in Office documents online,  45–46
previewing,  67
saving presentation as,  375–377

Video Tools Playback tab, Start On Click setting 
in,  371

View Ruler command, in Word,  123
views

modifying document,  119–122
OneNote,  659–660
setting options in Excel for,  574–578

View Side By Side button,  578
View tab

changing document view in,  119–122
Navigation pane from,  136
Slide Master view,  291

VLOOKUP() function,  478

W
web addresses

Excel format for,  432
selecting in Excel,  435

web browser, accessing notes in,  738–740
Web Layout view, in Word,  120
WEEKDAY() function,  477
What-If Analysis, performing,  498–502

widescreen format, changing presentation to,  297–
300

Widow/Orphan Control option,  204
wiki links,  704
Window control buttons

in Excel,  413
in Office,  7–8
in PowerPoint,  256
in Word,  118

Windows 7
modifying screen resolution,  14–15
starting Office application in,  4–5

Windows 8
modifying screen resolution,  14–15
starting Office application in,  4–5
tablet edition of,  101
Window control buttons,  7–8
Windows Explorer vs. File explorer,  92

Windows 8 tablet, using Onenote on,  747–748
Windows Explorer vs. File explorer,  92
Windows Phone

sharing notes via SharePoint on,  723
using OneNote on,  746–747

Windows Phone 8, adding new note in,  747
Windows RT

about,  101
on Windows 8 tablet,  748

.wmv formatted video, saving presentation 
as,  375–377

Word
about new features in,  123–129
alignment guides in,  127
composing documents

inserting special characters,  169–171
inserting symbols,  165–166, 168
using AutoCorrect,  167–168, 172–175
using building blocks,  176–180
using formatting marks in,  161–164
using international characters,  167–168

correcting proofing errors,  230–232
creating across applications coordinating 

documents,  128
documents,  134–135
documents created in earlier versions of,  129
editing documents
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moving cursor by keyboard shortcuts,  155–156
selecting text,  156–160

file extension for,  116
formatting documents

about,  183–188
changing case of text,  200–201
exploring character formatting,  200–201
exploring paragraph formatting,  196–198
managing pagination through,  203–207
setting default documents,  188–190
setting section formatting,  190–192
using styles for,  192–196

heading styles in documents,  141–144
inspecting documents before publishing,  233–237
Layout Options button in,  127
Live Layout in,  127
making documents final,  238
modifying document view,  119–122
online pictures feature in,  45
opening files from cloud,  90–91
PDFs

creating,  239–244
editing,  239, 243–244
Reflow feature,  124

presentations, inserting online video into,  65–69
presenting information in

inserting tables,  217–223, 223–227
using bulleted lists,  209, 210–213
using numbered lists,  209, 210–213
using tabbed lists,  210, 213–217
using tables,  210

Read Mode
exploring research tools in,  148–152
viewing documents in,  144–148

recovering unsaved files in,  24
resume reading feature in,  124
ribbon,  117–119
saving files on cloud,  85–87
scrolling documents,  134–135
selecting document content,  157
setting default formatting for documents,  128
splitting screen in,  122–123
starting,  115–116
tables,  125
threaded comments in,  126

tracking changes in documents,  126
turning on ruler display,  122
using Navigation pane,  135–141
word completion, in touch mode,  105
Zoom group in,  120–121

WordArt Styles group
from Drawing Tools Format tab,  646
Text Effects button from,  348
Text Effects button in,  646

word completion, in touch mode,  105
Word Start screen,  116
Word Web App, viewing documents in,  239
workbooks

changing number of sheets setting in,  417
creating multisheet,  606–610
displaying separate windows,  414
managing multiple,  618–621
manipulating sheets in,  610–613
summarizing multisheet,  613–616

WORKDAY() function,  477
worksheets

cells in. See also cells, spreadsheet
creating bottom border in,  425
deleting,  587–591
finalizing entry in,  424
inserting,  587–591
maximum number of rows,  458

changing widths of columns,  423–426
changing widths of rows,  426
charts in,  623–629. See also charts
creating and sharing graphics,  642–648
creating PivotTables,  526–533
formatting

applying number,  538–541
applying percentage format to numbers,  558–

560
cells,  550–551
Clear Formats option,  546
creating custom themes,  546–549
custom number formats,  551–558
dates,  564–570
lining up positive and negative numbers in 

columns,  541
setting view options,  574–578
with styles,  542–545
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working with fractions,  560
inserting columns,  583–587
inserting rows,  583–587
jumping to first cell in,  520
moving and copying columns and rows on,  445–

446
moving around,  439–441
page layout options,  591–599
pages in

adjusting page breaks,  602–606
printing row and column labels,  599–602

panes,  591–599
performing What-If Analysis,  498–502
protecting,  570–572
sheet references in,  617–618
storing formats in templates,  579–580
using built-in templates,  495–498

Wrap Text button,  444
Wrap Text format,  426

X
XML Paper Specification (XPS) format, saving files 

in,  22
XPS (XML Paper Specification) format, saving files 

in,  22

Y
YouTube

getting embed code from,  375
inserting videos into presentations,  374–375

YouTube video page,  375
y (Year), Excel date formatting code,  569

Z
zero (0), as Excel formatting code,  554
Zoom button,  652
Zoom dialog box,  121
Zoom group

in Excel,  603
in OneNote,  663

in Word,  120–121
zoom, in touch mode,  106
Zoom slider,  389
Zoom tool, in PowerPoint during 

presentations,  399–400
Zoom to Page button, in viewing presentation 

comments,  389
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What do 
you think of
this book? 
We want to hear from you! 
To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey 

Tell us how well this book meets your needs—what works effectively, and what we can 
do better. Your feedback will help us continually improve our books and learning  
resources for you.   

Thank you in advance for your input! 
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